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This document is copyrighted with All Rights Reserved. Under copyright laws, this
document must not be copied in full or in part, or reproduced by any other media,
without the express written permission of Coherent, Corp. (Coherent). Permitted copies
must have the same proprietary and copyright notices as were attached to the original.
This exception does not permit copies—whether or not sold—to be made for others;
however, all the material purchased can be sold, given, or loaned to another person.
Under the law, “copying” includes translation into another language.

Coherent, the Coherent Logo, and the PowerMax USB/RS Sensor System are
registered trademarks of Coherent, Corp. All other trademarks or registered trademarks
are the property of their respective owners.

Patents referenced in this manual are active when the manual is printed (see last page
for the date). You are advised to check if the patents are still active
www.coherent.com/legal/patents.

Every effort was made to make sure that the data shown in this document is accurate.
The information, figures, tables, specifications, part numbers, and schematics
contained in this manual are subject to change without notice. Coherent makes no
warranty or representation, either expressed or implied, related to this document. In no
event will Coherent be liable for any direct, indirect, special, incidental, or consequential
damages caused by any defects in its documentation.

Technical Support

In the U.S.:

Should you experience any difficulties with your product or need any technical
information, please go to our web site www.Coherent.com. Should you need further
assistance, please contact Coherent Technical Support by e-mail
customer.support@coherent.com or telephone, +1-734-456-3100. Please be prepared
to supply the model and serial number of your device,   the description of the problem,
and any attempted corrective steps to the Product Support Engineer responding to your
request.

Telephone coverage is available Monday through Friday (except U.S. holidays and
company shutdowns). Inquiries received outside of normal office hours will be captured
by our automatic answering system and will be quickly returned the next business day.

Outside the U.S.:

If you are located outside the U.S., please visit www.Coherent.com for technical
assistance, or contact your local Service Representative. Service Representative
telephone numbers and addresses can be found on the Coherent web site.

Coherent provides telephone and web-based technical assistance as a service to its
customers and assumes no liability for any injury or damage that can occur at the same
time with such services. Under no conditions do these support services affect the terms
of any warranty agreement between Coherent and the buyer. Operation of any
Coherent laser with any of its interlocks defeated is always at the operator's own risk.

© Coherent, Corp. 2024. All rights reserved.
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Introduction 
1 Introduction

1.1 Signal Words and Symbols in this Manual

This documentation may contain sections in which particular hazards are
defined or special attention is drawn to particular conditions. These
sections are indicated with signal words in accordance with ANSI Z-535.6
and safety symbols (pictorial hazard alerts) in accordance with ANSI
Z-535.3 and ISO 7010.

1.1.1 Signal Words

Four signal words are used in this documentation: DANGER, WARNING,
CAUTION and NOTICE.

The signal words DANGER, WARNING and CAUTION designate the
degree or level of hazard when there is the risk of injury:

DANGER!
Indicates a hazardous situation that, if not avoided, will result in
death or serious injury. This signal word is to be limited to the most
extreme situations.

WARNING!
Indicates a hazardous situation that, if not avoided, could result in
death or serious injury.

CAUTION!
Indicates a hazardous situation that, if not avoided, could result in
minor or moderate injury.

The signal word ‘NOTICE’ is used when there is the risk of property
damage:

NOTICE 
Indicates information considered important, but not hazard- related.
1
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Messages relating to hazards that could result in both personal injury and
property damage are considered safety messages and not property
damage messages.

1.1.2 Symbols

The signal words DANGER, WARNING, and CAUTION are always
emphasized with a safety symbol that indicates a special hazard,
regardless of the hazard level:

This symbol is intended to alert the operator to the presence of addi-
tional information.

This symbol is intended to alert the operator to the presence of
important operating and maintenance instructions.

This symbol is intended to alert the operator to the danger of expo-
sure to hazardous visible and invisible laser radiation.

This symbol is intended to alert the operator to the presence of
dangerous voltages within the product enclosure that may be of
sufficient magnitude to constitute a risk of electric shock.

This symbol is intended to alert the operator to the danger of
Electro-Static Discharge (ESD) susceptibility.
2
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This symbol is intended to alert the operator to the danger of poten-
tial hot surfaces.

This symbol is intended to alert the operator to the danger of
crushing injury.

This symbol is intended to alert the operator to the danger of a lifting
hazard.

1.2 Preface

This manual contains user information for the PowerMax USB/RS Sensor
System.

NOTICE
Read the associated documentation carefully before operating a
laser with the sensor for the first time. Failure to follow necessary
instructions and safety precautions can result in serious injury or
death.

DANGER!
Use of controls or adjustments or performance of procedures other
than those specified herein may result in hazardous radiation expo-
sure.

1.3 Export Control Laws Compliance

It is the policy of Coherent to comply strictly with U.S. export control laws.
3
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Export and re-export of lasers manufactured by Coherent are subject to
U.S. Export Administration Regulations, which are administered by the
Commerce Department. In addition, shipments of certain components are
regulated by the State Department under the International Traffic in Arms
Regulations.

The applicable restrictions vary depending on the specific product
involved and its destination. In some cases, U.S. law requires that U.S.
Government approval be obtained prior to resale, export or re-export of
certain articles. When there is uncertainty about the obligations imposed
by U.S. law, clarification must be obtained from Coherent or an
appropriate U.S. Government agency.

Products manufactured in the European Union, Singapore, Malaysia,
Thailand: These commodities, technology, or software are subject to local
export regulations and local laws. Diversion contrary to local law is
prohibited. The use, sale, re-export, or re-transfer directly or indirectly in
any prohibited activities are strictly prohibited.
4
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2 Safety

2.1 Introduction

Carefully review the following safety information to prevent personal injury
or damage to this product or any equipment connected to it. There are no
user-serviceable parts in Coherent PowerMax meterless power sensors.
For service information, refer to ’Obtain Service’ (p. 70).

2.2 Laser and Optical Safety

Laser light, because of its optical qualities, poses safety hazards not
associated with light from conventional light sources. The safe use of
lasers requires all operators, and everyone near a laser, to be aware of
the dangers involved. Users must be familiar with the instrument and the
properties of coherent, intense beams of light.

At all times, make sure that all personnel who operate, maintain or service
the laser are protected from accidental or unnecessary exposure to laser
radiation exceeding the accessible emission limits defined in the laser
safety standards

WARNING!
LASER RADIATION - AVOID EYE OR SKIN EXPOSURE TO DIRECT OR
SCATTERED RADIATION CLASS 4 LASER PRODUCT!

The greatest concern when using a laser is eye safety. In addition to the
main beam, there are often many smaller beams present at various
angles near the laser system. These beams are formed by specular
reflections of the main beam at polished surfaces such as lenses or
beamsplitters. While weaker than the main beam, such beams may still be
sufficiently intense to cause eye damage. 
5



PowerMax USB/RS User Manual
For safety information specific to the use of lasers, read and obey all
respective documentation provided by the manufacturer of the laser
system being used.

CAUTION!
Laser safety eyewear protects the user from accidental exposure to
laser radiation by blocking light at the laser wavelengths.

However, laser safety eyewear may also prevent the operator from
seeing the beam or the beam spot. Exercise extreme caution even
while wearing safety glasses.

2.3 Electrical Safety

The PowerMax USB/RS Sensor System does not have dangerous voltag-
es. 

NOTICE
Do not disassemble the enclosure. There are no user-serviceable parts
inside.

All units should be operated as assembled. The warranty is canceled if the
enclosure is disassembled. See ’Calibration, Warranty and Service’ (p. 67)
for assistance.

WARNING!
Do not operate the system if its panels are removed or any of the inte-
rior circuitry is exposed.

WARNING!
Do not operate the system in wet or damp conditions, or in an explo-
sive atmosphere.
6
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NOTICE
Do not operate the system if there are suspected failures. Refer
damaged units to qualified Coherent service personnel.

2.4 Safety Information for LM-200 Sensor

This section gives safety information specifically for the PowerMax
LM-200 sensors.

Devices must be IEC/EN 62368 or IEC 60950 tested and approved before
they are connected to the USB or RS-232 ports

2.4.1 LM-200 Safety Label and Information

The electrical safety label is found on the side of the module. It gives max-
imum power use, amperage and polarity information. Refer to Figure 2-1.

Figure 2-1.  LM-200 Sensor Electrical Safety Label
7
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The heat hazard warning label is found on the other side of the LM200
module. Refer to Figure 2-1.

2.5 ESD Protection

The most common ESD damage occurs when handling the device during
installation or use.

CAUTION!
Electrostatic charges as high as 4000 volts easily collect on the
human body and equipment and can discharge without detection. 

Although the electronics features have input protection, permanent
damage can occur on devices subjected to high-energy electrostatic
discharges. You must take correct ESD precautions to prevent
damage or performance degradation. 

The most common ESD damage occurs when handling a device during
installation or use. Take the necessary measures to protect the system
from ESD.

Dry air and carpet also create a higher potential for ESD. Remember to
take precaut ions or shielding not only for  operat ions,  but for
demonstrations or trade show exhibitions.

When mobile equipment (a cart or table) is used as an ESD-protected
workstation, connect it to ESD ground that meets ANSI/ESD S4.2 required
limits for an ESD-protected workstation (<1 x 109 ohms).

Figure 2-2.  LM-200 Sensor Heat Hazard Warning Label
8
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3 Compliance

3.1 Compliance to Standards Relevant to CE and UKCA 
Marks

The PowerMax USB/RS Power Meters are tested and marked as
independent products in the European Community (CE) and the United
Kingdom (UKCA). For specific details regarding what applicable
compliance directives and standards the products have been tested to,
refer to the EU Declaration of Conformity and/or the UKCA Declaration of
Conformity which are available upon request from Coherent, per contact
information on p. ii of this manual.

Compliance to applicable standards for a particular laser tool incorporating
PowerMax USB/RS User Manual must be demonstrated by the
manufacturer of the complete system. The primary issue for the system
integrator is to design covers, shielding, grounding, routing of electrical
cable assemblies, and control elements with the proper safety features so
that during subsequent testing the system meets the appropriate
standards.

3.2 Electromagnetic Compatibility

Compliance of this laser with the Electromagnetic Compatibility (EMC)
requirements is certified by the CE mark and the UKCA mark.

Each application and installation is unique, and in some cases, the user
may experience Electromagnetic Interference (EMI) noise being emitted
from various electronic components. This laser may use high-frequency
RF. While adequate countermeasures have been taken to suppress
this emission to meet the requirements stated on the Declaration of
Conformity, the user may wish to employ additional measures to suppress
the EMI to reduce the emissions further. Standard methods of reducing
the EMI are:

1. Use of shielded control cables grounded on both ends

2. Addition of appropriate ferrite beads to cables connected to the beam
source.
9
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3.3 Environmental Compliance

This section describes compliance with various environmental regulatory
directives to identify hazardous substances.

3.3.1 EU REACH

Coherent products are classified as ‘articles’ according to EU REACH
definition, as follows:

Article means an object which, during production, is given a special
shape, surface or design that determines its function to a greater degree
than its chemical composition. (REACH, Article 3(3))

Articles as defined by REACH regulations are exempt from registration as
long as they are not intended to release a chemical substance.

Coherent product(s) conform to all applicable requirements of the
EU-REACH Regulation, (1907/2006). Declarations of Compliance are
available upon request.

In addition, to the best of our knowledge, Coherent products do not
contain any Substances of Very High Concern (SVHC) above the legally
mandated thresholds included in the REACH SVHC list, which is updated
every six months. The current SVHC list is available on-l ine at
https://echa.europa.eu/candidate-list-table.

3.3.2 RoHS Compliance

Coherent product(s) conform to all applicable requirements of the
EU-RoHS Directive (2011/65/EU) and subsequent Amendment Directives
including Directive (EU) 2015/863. Compliance Declarations are available
upon request.

3.3.3 China RoHS Compliance

Coherent product(s) conform to all applicable requirements of Restriction
of Hazardous Substances Regulation SJ/T 11364-2014 commonly
referred to as China RoHS.

Hazardous  subs tances  ( i f  app l i cab le )  i n  the
PowerMax USB/RS User Manual are listed in the material declaration
table included with the equipment, REACH Compliance.
10
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Compliance 
Coherent product(s) conform to all applicable requirements of the
EU-REACH Regulation, (1907/2006). Compliance Declarations are
available upon request.

Any hazardous substances in Coherent products (if applicable) are shown
on the product label. 

The China RoHS label is as follows for the PowerMax USB/RS sensor:

The China RoHS Regulation also requires that the date of manufacture be
identified. This information is provided on the Certificate of Calibration
shipped with each product.

3.3.4 Waste Electrical and Electronic Equipment (WEEE, 2012)

The European Waste Electrical and Electronic Equipment (WEEE) Direc-
tive (2012/19/EU) is represented by a crossed-out waste container label
(F igure 3-1) .  WEEE management  a lso  covers  EU Di rec t i ve
2006/66/EC-EU Battery Directive and Directive 94/62/EC on Packaging
and Packaging Waste. Do not dispose of these products or packaging as
unsorted municipal waste.

Coherent joins approved compliance organizations to meet its collection
and recycling obligations. For further information, please contact: 

Email:  info@rene-europe.com

Phone:  +49 (0) 8266-869806

Website:  www.rene-europe.com

 
Part Name 

       Hazardous Substances  
 

(Pb) 
 

(Hg) 
 

(Cd) 
 

(Cr(VI)) 
 

(PBB) 
 

(PBDE) 

PCB Assembly X O O O O O 

 
Hardware X O O O O O 

Cable Assembly X O O O O O 

SJ/T 11364  

O: GB/T 26572  
X: GB/T 26572  

Figure 3-1.  Waste Electrical and Electronic Equipment Label
11
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3.4 Declaration of Conformity

Declaration of Conformity certificates are available upon request.
12
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4 Description

4.1 Introduction

Coherent PowerMax-USB and PowerMax-RS sensors are the world’s first
laser power sensors that use state of the art microelectronics miniaturiza-
tion techniques and integrate an entire instrument within a USB 2.0 or
RS-232 cable connector. Specifically, PowerMax-USB and PowerMax-RS
sensors have all the signal processing and power measurement electron-
ics normally in a LabMax meter and connect directly to a PC with
plug-and-play functionality. Ideally adapted for low- and high-volume em-
bedded sensor applications, Coherent’s new family of sensors removes
the need for a separate meter box, thus delivering a significant savings in
cost and space, but with no decrease whatsoever in performance.

This measurement platform can also be used to measure the energy in a
long laser pulse—normally greater than 1 millisecond in pulse width—by
integrating the output of a thermopile sensor.

A software application (PowerMax PC or Coherent Meter Connection)
supplies a virtual instrument interface for sensors that enable the operator
to take laser power readings, log data, and compute measurement statis-
tics. Users can also write their own software with host interface com-
mands that control all aspects of power meter operation.

For the first time, separate electronics are no longer required between the
sensor and a PC. For those customers who can use a PC for monitoring
laser power, these sensors make available significant cost savings, space
savings, and no decrease in performance.

WARNING!
To avoid potential hazard due to back reflection when PowerMax
sensors are used with lasers, protective measures must be used
before each use. These measures must be used and include protec-
tive shielding and protective equipment.

4.2 Product Overview

4.2.1 Product Features

• PowerMax-USB provides direct USB 2.0 connection to a PC. Power
is supplied through a USB connection.
13
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• PowerMax-RS provides RS-232 connectivity. Power input is supplied
by a +5VDC input (power supply is available as an optional acces-
sory).

• Instrumentation platform is compatible with thermopile and optical
sensors and can be adapted to most power sensors that Coherent
manufactures.

• Displays beam position with position-sensing quadrant thermopiles
(for example LM-model sensors like the LM-10).

• High resolution 24-bit A/D converter supports four digits of resolution
and measurement accuracy equivalent to that found in Coherent's
LabMax meters.

• Sensors include spectral compensation for accurate use at wave-
lengths that are different from the calibration wavelength. Each
sensor receives an unique spectral compensation curve specific to
the responsivity of its specific element, as well as transmission char-
acterization of any related optics.

• Thermopile sensors include a speed-up algorithm that speeds up the
normal response of the thermopile detector without overshoot.

• LED status indicators inside USB and RS-232 connectors give
health-and-status information.

• Thermopile sensors offer long-pulse joules capability.

4.2.2 Software Features

Plug-and-play application software, Coherent Meter Connection, is sup-
plied standard and includes the following features:

• Trending

• Statistics (mean, minimum, maximum, and standard deviation) and
log batch to file.

• Tuning

• Display beam position on position-sensing thermopiles and log
results to file

• Histogram view

•  Operate several sensors at the same time
14
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• Perform synchronized ratiometry (A/B analysis) (with PowerMax PC
software). Trend and log results to file.

• For LaserPAD or SSIM customers, the host command set includes
drop-in compatibility.

• For system integrators and for implementations that include
customer-written software, the sensors include a complete command
set that is easy to access:

• Utilize a Windows USB driver and supports simple ASCII host
commands for remote interfacing using both PowerMax-USB and
PowerMax-RS sensors. 

• Use customer-written software, the remote interfacing host command
set permits sensors to be remotely controlled.

• National Instruments™ LabVIEW™ driver is supplied for easy
LabVIEW integration.

Figure 4-1.  Software Interface (Coherent Meter Connection)
15
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4.3 Technical Description

4.3.1 Thermopile Technology

Thermopile sensors are a great all-purpose technology suitable for many
lasers. They are used for measuring CW laser power, average power in
pulsed lasers, and are frequently used to integrate the energy of long
pulses. Thermopile sensors absorb incident laser radiation and convert it
into heat. This heat ultimately flows to a heatsink that is held at ambient
temperature by either convection-cooling or water-cooling. The tempera-
ture difference between the absorber and the heatsink is changed into an
electrical signal by a thermocouple junction.

Thermopiles operate across a wide range of input powers, and unlike a
photodiode-based sensor they will not saturate. The spectral range is de-
pendent on the coating applied to absorb the laser power. The coating
used on many thermopiles is broadband in nature and is relatively flat
from the ultraviolet through the infrared.

These sensors have normal response times on the order of several sec-
onds for a low power sensor and up to one minute for a kilowatt sensor.
The exponential nature of the natural thermopile output permits one to
electronically increase the voltage to its final value ahead of the actual
sensor signal using a software algorithm. 

This capability is typically called a ’speed-up’ algorithm. When combined
with the PowerMax-USB and PowerMax-RS circuitry, a speed-up algo-
rithm can be applied to provide a much faster response—on the order of
seconds or less for most thermopile sensors. This feature can be turned
on and off in the software.

Coherent has two main types of thermopile sensors:

• The LM Model line uses a unique thermopile disk in which the ther-
mocouples are divided into four quadrants, letting the sensors provide
beam position information in addition to power measurement.

• The PM Model line incorporates traditional thermopile disks that
supply power measurement without beam position information.

PowerMax-USB and PowerMax-RS sensors can use both types of ther-
mopile sensors. 
16
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4.3.1.1 Long-Pulse Energy Measurement With a Thermopile

Thermopile sensors are most commonly for average power measure-
ments on pulsed and CW lasers. A unique function of thermopile sensors
is the ability to integrate the power of a single “long” laser pulse (long
pulse refers to pulses roughly 1 millisecond up to several seconds in pulse
length).

The instrumentation analyzes the output of the thermopile and applies the
integration through the use of an algorithm that results in a Joules reading. 

This lets the thermopile measure the energy of single pulses between 1
millisecond and 10 seconds in length, and with energies from millijoules to
hundreds of Joules. The measurement accuracy of this mode is typically
better than ± 3% when performed with PowerMax-USB and Power-
Max-RS sensors.

This capability is very useful for what are commonly called long-pulse
medical or industrial type lasers. Common applications for this type of
measurement are in the medical field—especially skin resurfacing and
hair removal—and in material processing applications, for example laser
welding. These laser systems frequently use high-energy lasers that have
large beam sizes and relatively long pulses.

Figure 4-2.  Coherent Thermopiles
17
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This type of measurement requires careful selection of the applicable
power sensor, based upon the laser pulse being measured. A good ’rule
of thumb’ for using a thermopile for this type of measurement is to com-
pare the maximum pulse energy you need to measure (in Joules) with the
maximum power rating of a sensor (in Watts).

Frequently a sensor such as the PM150-50C is best for these measure-
ments. It features a large 50 mm aperture size, can handle pulse energies
up to 150J, and can be used air-cooled for single pulse energy measure-
ments. A PM150-50C normally needs to be water-cooled for continuous
power measurements. The PS19Q sensors, on the other hand, permit
long-pulse measurements down into the mJ level.

For an up-to-date list of all compatible sensors and their specifications, go
to: www.Coherent.com/LMC.

4.3.2 Semiconductor Technology

Semiconductor photodiode-based sensors convert incident photons into
current that can be measured by our instrumentation. We normally refer to
these devices as optical sensors or quantum sensors. The photodiodes
used in these types of sensors offer high sensitivity and low noise, en-
abling them to detect very low light levels. The UV/VIS optical sensor in
the PowerMax-USB line is designed to measure power of CW sources, as
well as the average power of pulsed sources, as long as the repetition rate
is above 100 pps. Photodiodes also have a fast response time, making
this senor convenient for tuning and peaking lasers.

These types of sensors have several orders of magnitude higher sensitivi-
ty than thermopile sensors and are quite stable. They do, however, suffer
from photocurrent saturation. The UV/VIS sensor incorporated into the
PowerMax-USB product line includes an attenuating filter that allows the
sensor to be used into the hundreds of milliwatt level without saturation.
This ND filter, and the light shield threaded onto the front of the sensor,
also help to block stray light, thereby resulting in a lower noise floor.

Coherent incorporates spectral compensation in the PowerMax-USB and
PowerMax-RS UV/VIS sensor to give accurate measurements across the
325 to 1065 nm spectrum. Because the spectral response of the ND filter
and photodiode varies significantly across this wavelength range, always
check the maximum measurable power at the wavelength of use to make
sure the sensor is not being saturated. Figure 4-3, below, indicates the
maximum and minimum measurable power levels by wavelength.
18
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The curve in Figure 4-3shows a plot of the maximum measurable power,
which is the saturation level of the photodiode. It also shows the minimum
recommended power level, by wavelength for the PowerMax-RS UV/VIS
sensor. 

UV/VIS Temperature Linearity: Like all silicon photodiodes, the UV/VIS
Quantum sensor has temperature sensitivity in the infrared region. At
1064 nm, for example, it has a 0.5%/ºC thermal coefficient. Because of
the electronics inside the sensor, measurement error up to 2% is present
at 1064 nm after a 10-minute warm-up time. Additional error can be pres-
ent if the ambient measurement environment is different from the calibra-
tion wavelength shown on the calibration certificate.

In practice, wavelengths shorter than 1000 nm have insignificant effects
caused by temperature.

The following figure references the thermal coefficient at the wavelength
of use.  

Figure 4-3.  Saturation & Minimum Power -
PowerMax-USB UV/VIS Quantum Sensor
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4.3.3 LM-200 Maximum Laser Power Handling

The LM-200 Power Sensor can measure laser power up to 100W continu-
ously with the fan on. For power levels between 100W and 200W, the fan
must be on and the measurement time must not exceed five minutes. Af-
ter measurements above 100W, please wait for five minutes to let the sen-
sor cool down before another measurement is taken.

Without the fan, the LM-200 can measure up to 50W continuously. For
power levels between 50W and 100W without the fan, the measurement
time must not exceed ten minutes. After measurements above 50W with-
out the fan, please wait for five minutes to let the sensor cool down before
another measurement is taken.

4.3.4 Equipment Ratings

The power sensors are usable under the following conditions:

• Internal use only

• 0m to 2000m altitude

• 5 deg C to 40 deg C, and 41 deg F to 105 deg F temperatures

• 80% relative maximum humidity

• Main voltage fluctuation not more than +/- 10%

Figure 4-4.  Photo Sensitivity Temperature Characteristics
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• Transient over-voltages category II

• Pollution level 2

4.4 Apply Wavelength Compensations

Overall measurement accuracy is a combination of:

• Calibration uncertainty. Note: For an up-to-date list of all compatible
sensors and their specifications, go to : www.Coherent.com/LMC.

• Wavelength compensation accuracy—refer to Table 4-1, “Wave-
length Compensation Accuracy,” on page 22.

The combined accuracy is based upon practices outlined in the National
Institute of Standards Guidelines for Evaluating and Expressing Uncertain-
ty. The combined accuracy of the measurement is calculated by using the
law of propagation of uncertainty using the ‘root-sum-of-square’ (square
root of the sum of squares), sometimes described as ‘summing in quadra-
ture’ where:

Measurement Accuracy = 

where:

U = Percent Calibration Uncertainty
W = Wavelength Accuracy

Example:

PowerMax-USB LM-10 used at 1064 nm

U = 2%
W = 1.5%

Measurement Accuracy = %

Coherent uses three primary coatings to capture the incident radiation on
our thermal sensors. The specifications for each sensor list which coating
is used. 

Typical wavelength ranges and response curves for these coatings are
shown in Figure 4-5, below. Each sensor has a spectral curve created
from reflectance measurements taken with spectrometers. The reflectance
data are converted into a wavelength compensation look-up table that is
loaded into the sensor. This data is accessed by selecting a wavelength of
operation in the software.  

Table 4-1 shows the spectral compensation accuracy for each type of sen-
sor.

U2 W2+

22 1.52+ 4 2.3+ 2.5= =
21

http://www.Coherent.com/LMC


PowerMax USB/RS User Manual
4.5 LED Status Indicators

Blue LED lights are contained within the PowerMax-USB and Power-
Max-RS connectors to supply health-and-status information.

Figure 4-5.  RV Spectral Correction for Thermal Sensors (Normalized to Calibration Wavelength)

Table 4-1.  Wavelength Compensation Accuracy

Sensor

Wavelength Compensation
Accuracya

Calibration
Wave-
length 
(nm)

All PM- and LM-model thermopiles ± 1.5% 10600

PS model ± 1.5% 514

UV/VIS optical model ± 4% (325 to 900 nm)
± 5% (900 to 1065 nm)

514

a. Refers to wavelengths different from the calibration wavelength.
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4.5.1 PowerMax-USB LED Lights

Table 4-2.  PowerMax-USB LED Light Conditions

LED Light 
Condition Status

No light visible If the PowerMax-USB sensor is connected to the PC but 
there are no visible lights, the sensor is not powering up 
correctly. Test the sensor on another USB port and if 
that does not solve the problem, contact Coherent for 
service—refer to Table 8-1 (p. 71) for contact informa-
tion.

Lights flashing 
slowly (0.5 Hz)

Sensor is in operation; however, the driver has not been 
properly loaded. First, make sure power is being prop-
erly applied to the USB port. If that does not solve the 
problem, remove the sensor from the USB port and 
reinstall the software from the CD that shipped with the 
product (or download the latest software from our 
website: www.Coherent.com).

Lights slowing 
ramping up and 
down in intensity

Sensor is in operation and the driver has been correctly 
loaded.

Lights flashing fast 
(10 Hz)

The sensor is taking power measurements and sending 
data over the host port.

Blue LED

Blue LED
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4.5.2 PowerMax-RS LED Lights

Figure 4-6.  LED Lights — PowerMax-RS

Table 4-3.  PowerMax-RS LED Light Conditions

LED Light Condition Status

No light visible If + 5VDC has been applied to the 
PowerMax-USB sensor but there are no 
visible lights in the connector, the sensor is 
not powering up properly. Contact Coherent 
for service—refer to Table 8-1, “Coherent 
Service Centers,” on page 71 for contact 
information.

Lights slowing ramping up 
and down in intensity

Power has been applied to the sensor and it 
is in operation.

Lights flashing fast (10 Hz) The sensor is taking power measurements 
and sending data over the host port.

Blue LEDs
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5 Installation and Operation

This section gives information about how to start the software installation,
to provide power to the sensors, to take a power measurement and to un-
derstand and use the software.

5.1 Install the Software

Install the Coherent Meter Connection Software. For requirements and in-
structions, refer to the Coherent Meter Connection User Manual (P/N
1343658 Rev AC). 

The software for download and the software user manual are available at:

www.coherent.com/resources

5.2 Provide Power to PowerMax-RS Sensors

The PowerMax-RS sensor is powered by a provided +5 VDC, 1.5A
(100-240V input) power supply input (Model GT-46181-1812-T3, Coherent
P/N 1105427).

Figure 5-1.  Power Supply for the PowerMax-RS Sensor

Power
supply

Sensor
power cable
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Also, an LPS power supply with 100-240V AC 50-60Hz 0.5A and 12V DC
IEC62368-tested power supply can be used.

5.3 Provide Power to LM-200 Power Sensor

To attach power the sensor, do the following:

1. Attach the power supply barrel connector into the input port on the
side of the sensor. Refer to Figure 5-2.

2. Attach the power cord to the power supply.

Use only the correct 5V power supply.

3. Then, attach the power cord from the power supply into the main
power source.

Power supply must be connected to power sockets with protective
earth ground. The power supply connector must be accessible.

The fan comes on when power is applied.

CAUTION!
The sensor can become hot during operation. Do not touch or
handle the sensor during or immediately after operation.

Figure 5-2.  Attach Power Connector to LM-200 (not connected - left, connected - right)
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This symbol is intended to alert the operator to the danger of poten-
tial hot surfaces.

5.4 Extend Cable Length

USB sensors: The PowerMax-USB cable is 2.5 meters long. USB hubs
can be used to increase the length of the cable. The USB standard per-
mits up to five hubs—connected in series with 5-meter cables connecting
the hubs—thus providing a maximum range of 27.5 meters. 

There are also active 5-meter USB extension cables on the market that
perform as if they were a USB hub, but for just a single USB sensor. (Feel
free to contact Coherent for advice related to particular hubs we have test-
ed in-house.)

RS sensors: The RS cable is 300 mm long. It is intended to be used with a
standard off-the-shelf RS-232 extension cable to extend the length.

5.5  Take a Power Measurement

This section shows two quick-start ’mini-tutorials’ that tell how to connect a
PowerMax-USB or PowerMax-RS sensor to a PC and start taking mea-
surements with the Coherent Meter Connection software.

In addition to the Coherent Meter Connection (CMC) software, a previous
software application called PowerMax PC is also compatible with Power-
Max-USB and PowerMax-RS sensors. This older application works well in
a Windows 10 environment; it supports ratiometric operation which is not
supported by Coherent Meter Connection. Coherent Meter Connection is
recommended for all other applications.

For procedures with the use of PowerMax PC software, refer to ’Operation
with PowerMax PC’ (p. 77).

NOTICE
Procedures and figures in this section show the Coherent Meter
Connection version of the software.

For instructions about communicating with the sensor directly through
host commands, refer to ’Host Interface’ (p. 39).

Tutorials with use of the CMC software include:
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• Measure power with a PowerMax-USB thermopile sensor (p. 28).

• Measure power with a PowerMax-RS thermopile sensor (p. 29).

WARNING!
Follow all laser safety procedures. The laser must be switched OFF
or shuttered before running the tutorials given in this section.

5.5.1 Measure Power With a PowerMax-USB Thermopile Sensor

This quick-start tutorial describes how to take a power measurement with
a PowerMax-USB thermopile sensor with the use of CMC software.

WARNING!
Make sure that the laser is set to OFF or shuttered before this tutorial
is started.

4. Attach the PowerMax-USB sensor to
the USB port on the PC.

5. Make sure that the blue LEDs on the
USB connector come on and slowly
ramp up and down in intensity (which
signifies the sensor is operating and the
driver is correctly loaded).

6. Start the CMC software.

Blue LED

Blue LED
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7. Click Open Meter in the main drop-down
menu.

8. From the dialog box, select the COM port to
which the PowerMax-RS sensor is attached.
The COM port number is automatically
determined by the computer. (If needed,
check in Device Manager for available COM
ports.)

9. Click the Zero button to zero out any
offset in the sensor.

10. Click the Start button, and then set
the laser to ON to start to take power
measurements.

5.5.2 Measure Power With a PowerMax-RS Thermopile Sensor

This quick-start tutorial shows how to get a power measurement with a
PowerMax-RS thermopile sensor with the use of CMC software.

WARNING!
Make sure that the laser is set to OFF or shuttered before starting
this tutorial.
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1. Attach the PowerMax-RS sensor
into an available RS-232 COM port
on the computer.

2. Attach the +5VDC power supply 
cable into the sensor power cable and 
the power supply into a wall electrical 
outlet. NOTE: The power 
supply—P/N 1105557— is available 
from Coherent as an optional accessory. 

3. Make sure that the blue LEDs on the RS
connector come on and slowly go up and down
in intensity (which signifies the sensor is
working). 

4. Start the Coherent Meter Connection or
PowerMax PC software.

5. Click Open Meter from the main drop-down
menu.

6. From the dialog box, select the COM port to
which the PowerMax-RS sensor is attached.
The COM port number is automatically
determined by the computer. (If needed,
check in Device Manager for available COM
ports.)

When the COM port is selected, 
the software scans that port and 
identifies the connected 
sensor/meter.

.
7. Make sure that the laser is set to

OFF or shuttered until the sensor is set to zero.

Sensor power cable

Power supply 

Blue LEDs 
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8. Put the sensor into the beam path.

9. Click the Zero button to zero out any
offset in the sensor.

10. Click the Start button and then set
the laser to ON to start to take power
measurements.

5.6 Understand and Use the CMC Software

This section describes the user interface, settings, and other key functions
of the Coherent Meter Connection (CMC) software. For more details, re-
fer to the Coherent Meter Connection User Manual (P/N 1343658).

For description of the legacy PowerMax PC software, refer to ’Under-
stand and Use the PowerMax PC Software’ (p. 82).
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5.6.1 Home Screen

The main screen appears when the software is started. From here, users
can enter parameters, select modes, change ranges, start/stop data ac-
quisition, view the output in a chart format, and more. 

Key software functions through the Home screen are discussed next.

5.6.2 Quick Start Icons

Table 5-1 shows these icons and a brief description of each. The descrip-
tion also lists any alternate locations in the software for the same com-
mand. 

Table 5-1.  Quick Start Icons

Ico
n Description Same function as…

Access to Windows 
system menu

Includes standard Windows actions: Restore, 
Move, Size, Minimize, Maximize, and Close.

Opens a COM port 
connection to the meter

Drop-down menu > Open Meter command.

Clear the contents of the 
Capture Buffer

Drop-down menu > Meter Operation > 
Clear Buffer command.
Also on the Home Tab > Clear icon.
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5.6.3 Set the Sensor to Zero

Press of the Zero button starts the Zero function and sets the current sen-
sor input as the baseline for future measurements. It is recommended to
set the sensor to zero after first turning it on and before starting any new
set of power measurements.

When a zero procedure is in process, no other button events are queued
or started until the procedure ends. The zero procedure immediately stops
if the sensor is disconnected or if an error happens.

Normally, the Zero button must be clicked while the laser is set to off, or
while the laser beam is blocked. If a finite power level is present at the
sensor, the instrumentation will try to zero it out.

The sensor can only zero a finite level of offset equivalent to approximate-
ly 10% of full scale range.

NOTICE
If set to zero is not successful—which means the power input is too
large to set to zero—set to zero again in a more stable environment
or select a different range.

5.6.4 Set the Wavelength

The wavelength must always be set for accurate power measurements.
This can be done either in the Coherent Meter Connection application
software or over the host port via a host command.

Measure the sensor’s 
zero baseline

Drop-down menu > Meter Operation > 
Zero Meter command.
Also on the Home Tab > Zero icon.

Start streaming measure-
ments

Drop-down menu > Meter Operation > 
Start Measurements command.
Also on the Home Tab > Start icon.

Stop streaming measure-
ments

Drop-down menu > Meter Operation > 
Stop Measurements command.
Also on the Home Tab > Stop icon.

Table 5-1.  Quick Start Icons (continued)

Ico
n Description Same function as…
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The drop-down menu at the very top of the window, in CMC, displays the
available wavelengths, as shown in the example in Figure 5-3.  

5.6.5 Meter Operation and Start/Stop Data Collection

The Start and Stop Measurements functions enable/disable sample collec-
tion, including:

• The Trending chart

• Synchronized trending, if enabled

• The Histogram chart

• The Tuning chart

• All statistic and live reading indicators

• Data logging, if active 

Figure 5-3.  Quick Start —Laser Wavelength
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5.6.6 Software User Interface, Options and Controls

For detailed descriptions and information about the software user inter-
face, settings, and controls, refer to the Coherent Meter Connection user
manual.

Topics include the following and more:

• View Options

• Limits and Alarms

• Analysis Options

• Operating Modes

• Data Logging

• Data Buffer

• Measurement and Wavelength Settings

• Trigger Settings

• Condition Indicators

• Tuning, Trending and Histogram Panels
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6 Advanced Procedures

6.1 PowerMax Communications Through a Terminal 
Emulator

The procedure described in this section works for both PowerMax-RS
sensors and PowerMax-USB sensors.

NOTICE
PowerMax-USB sensors only: Before the following procedure is done,
install the Coherent Meter Connection or PowerMax PC software to
make sure that the USB driver is correctly installed on the computer.
For information on how to add a sensor, refer to ’Measure Power With
a PowerMax-USB Thermopile Sensor’ (p. 28).

1. Open the Device Manager on the computer and look for Coherent
PowerMax RS or USB Sensor under the Ports (COM & LPT) heading. 

In the example below, the PowerMax-USB sensor is COM12. 

2. Open HyperTerminal (or an equivalent program) and select the port
with which you want to communicate.

Figure 6-1.  Device Manager Location
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3. Set the following COM (communication) port settings:

• Baud rate: 9600

• Data bits: 8

• Parity: None

• Stop bits: 1

• Flow control: None

The following screens are set-up examples specifically for HyperTerminal:  

HyperTerminal is now available to send and receive basic commands. The
following example shows the ‘PW?’ query and the related response from
the PowerMax-USB sensor.  

Figure 6-2.  HyperTerminal Setup

Figure 6-3.  PW Query Example
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7 Host Interface

In this section:

• ’Introduction’ (p. 39)

• ’Message Terminators’ (p. 40)

• ’Host Command Quick Reference’ (p. 41)

• ’SCPI Interface Section’ (p. 44)

• ’Legacy LaserPAD/SSIM Interface Section’ (p. 58)

• ’Data Streaming Transmission Interface Gating Section’ (p. 64)

• ’Operational Parameters’ (p. 65)

• ’RS-232 Port Settings’ (p. 66)

7.1 Introduction

For those customers who want to communicate with Coherent Power-
Max-USB and PowerMax-RS sensors over a host interface—instead of
using the Coherent Meter Connection software—we are providing a com-
plete remote host command interface that can be used to control all as-
pects of sensor operation. Use this host interface environment to
communicate with these sensors in an ad hoc manner using a terminal
emulator, or to write custom software in a number of programming envi-
ronments, including Visual Studio and LabVIEW.

The PowerMax-USB sensors utilize a standard Windows COM class driv-
er and operate much like a serial port. After the driver is installed, the sen-
sor will show up as a device on the computer's COM port and the host
interface will accept commands and respond in ASCII format using com-
mands that adhere to the SCPI standard. 

The sensors also support a second ASCII command set used by our lega-
cy LaserPAD/SSIM products, which allow drop-in software compatibility.
For new software installations, we recommend using the newer SC-
PI-based command set.

For customers who prefer to capture streaming data over the host
port—instead of the query method—we have implemented a special data
streaming command interface. This interface requires the user to monitor
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for a high/low bit—as described under ’Data Streaming Transmission In-
terface Gating Section’ (p. 64)—and is a more advanced interface than
the standard SCPI ASCII command language. 

For customers who want streaming, and who want to stream in a purely
ASCII format, there is a command in the legacy LaserPAD/SSIM com-
mand set that can be used—refer to ’Legacy LaserPAD/SSIM Interface
Section’ (p. 58).

The PowerMax-RS sensors support the same command set as the Pow-
erMax-USB sensors. No driver is required, as they function as a serial de-
vice on an RS-232 port.

For customers who prefer to program in the National Instruments Lab-
VIEW environment, we provide a full set of LabVIEW drivers on the instal-
lation CD that shipped with your system. In addition to a basic Getting
Started VI that shows how to initiate communication with a Power-
Max-USB or PowerMax-RS sensor, we also provide access to the archi-
tecture of our PowerMax PC software, which was written using our
LabVIEW driver library.

7.2 Message Terminators

Messages between the sensor and the host computer are comprised en-
tirely of ASCII string characters, and all message strings passing through
the host interface are terminated to signal the end of a message string.

The one exception to messages comprised entirely of ASCII string charac-
ters is the Data Streaming Transmission Interface. After data streaming is
initiated, the host sends unsolicited streaming data in non-ASCII format in
which a high bit is set on all transmissions. The streaming data mode is
covered under “Start Data Streaming Command” and “Stop Data Stream-
ing Command” beginning on p. 62.

7.2.1 Messages Received by the Sensor

Messages received by the sensor must be terminated by a carriage return
(decimal 13). Line feed characters (decimal 10) are discarded so message
terminator flexibility can be attained. A command or query is considered
incomplete without the terminator. The maximum length of any message
received by the sensor is 200 bytes.
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7.2.2 Messages Sent by the Sensor

All legacy SSIM messages sent by the sensor—defined under ’Legacy La-
serPAD/SSIM Interface Section’ (p. 58)—are terminated by a carriage re-
turn.

All other messages sent by the sensor—defined under ’SCPI Interface
Section’ (p. 44) and ’Data Streaming Transmission Interface Gating Sec-
tion’ (p. 64)—are terminated by a carriage return and line feed pair.

7.3 Host Command Quick Reference

The following table gives a brief description of all host commands. For de-
tailed information about a specific command, go to the page referenced in
the right-hand column.

Table 7-1.  Host Command Quick Reference (Sheet 1 of 4)

Command Description Page 
#

SCPI Interface

SCPI Common Commands

*RST Resets all operational parameters to their power-on 
states.

7-45

*IDN? Queries the sensor identification string. 7-45

System Options

SYSTem:STATus? Queries the system status. 7-46

SYSTem:INFormation:TEMPera-
ture?

Queries the sensor temperature. 7-46

SYSTem:SYNC Resets the system measurement sync timer. 7-46

SYSTem:SYNC? Queries the system measurement sync timer. 7-46

SYSTem:RESTore Restores the persistent data back to the factory 
settings.

7-47

SYSTem:COMMunicate:HAND-
shaking

Selects the state of SCPI message round trip hand-
shaking.

7-47

SYSTem:COMMunicate:HAND-
shaking?

Queries the state of SCPI message round trip hand-
shaking.

7-47
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Error Record Reporting and Collection

SYSTem:ERRor:COUNt? Queries the number of error records in the error queue 
at the time of the query.

7-49

SYSTem:ERRor:NEXT? Queries the next error record(s) in the error queue. 7-49

SYSTem:ERRor:ALL? Queries all error records in the error queue at the time 
of the query.

7-49

SYSTem:ERRor:CLEar Clears all error records in the error queue. 7-50

Measurement Setup and Control

CONFigure:MEASure Sets the sensor measurement mode. 7-50

CONFigure:MEASure? Queries the sensor measurement mode. 7-50

CONFigure:SPEedup Sets the speedup state. 7-50

CONFigure:SPEedup? Queries the speedup state. 7-50

CONFigure:WAVElength Sets the current wavelength. 7-50

CONFigure:WAVElength? Queries the current wavelength. 7-50

CONFigure:GAIN:COMPensation Enables or disables gain compensation. 7-51

CONFigure:GAIN:COMPensation? Queries the state of gain compensation. 7-51

CONFigure:GAIN:FACTor Sets the gain compensation factor. 7-51

CONFigure:GAIN:FACTor? Queries the gain compensation factor. 7-51

CONFigure:ZERO Sets the current measurement as the zero baseline 
measurement.

7-51

CONFigure:AMODe Selects the measurement accuracy mode. 7-52

TRIGger:PTJ:LEVel Selects the pulsed thermopile Joules mode trigger 
sensitivity level.

7-52

TRIGger:PTJ:LEVel? Queries the pulsed thermopile Joules mode trigger 
sensitivity level.

7-52

Command Description Page 
#

Measurement Data Record Item Select and Format

CONFigure:ITEMselect Selects the transmit data items 7-52

Measurement Data Record Reading

Table 7-1.  Host Command Quick Reference (Sheet 2 of 4)
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READ? Queries the last recorded measurement at the time of 
the query.

7-54

Sensor Information

SYSTem:INFormation:SNUMber? Queries the serial number. 7-56

SYSTem:INFormation:PNUMber? Queries the part number. 7-56

SYSTem:INFormation:MODel? Queries the model name. 7-57

SYSTem:INFormation:CDATe? Queries the calibration date. 7-57

SYSTem:INFormation:MDATe? Queries the manufacturing date. 7-57

SYSTem:INFormation:TYPE? Queries the sensor type and connection configuration. 7-57

SYSTem:INFormation:DIAMeter? Queries the aperture diameter. 7-57

SYSTem:INFormation:WAVE-
length?

Queries the default wavelength. 7-58

Legacy LaserPAD/SSIM Interface

h Queries the list of LaserPAD/SSIM commands. 7-58

*rst Resets all operational parameters to their power-on 
states.

7-59

*ind Queries the hardware description. 7-59

v? Queries the firmware version. 7-59

vp? Queries the data stream protocol version. 7-59

msn? Queries the serial number. 7-59

mcal? Queries the calibration date. 7-60

mfg Queries the manufacturing date. 7-60

df? Queries the sensor family. 7-60

app Queries the aperture diameter. 7-60

rmi Queries the minimum range. 7-60

rmx Queries the maximum range. 7-61

spd? Queries the speedup state. 7-61

spd Toggles the speedup state. 7-61

wl? Queries the default wavelength. 7-61

Table 7-1.  Host Command Quick Reference (Sheet 3 of 4)
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7.4 SCPI Interface Section

7.4.1 Syntax and Notation Conventions

Unless otherwise specified, all SCPI commands and queries follow the
syntax and notation conventions specified by the SCPI Standard. For
more information, refer to the SCPI Standard—found on the IVI Founda-
tion website.

All commands must end with a carriage return character. A carriage return
character instructs the meter that the full command has been received.

The base-10 numeric data format specification is used heavily in this doc-
ument. Unless otherwise specified, numeric data items are represented
as:

• Integer values

• Non-scientific notation floating point values

• Scientific notation floating point values (upper / lower case E)

For example, the following data values are functionally equivalent:

• 31256

• 31256.0

wv? Queries the current wavelength. 7-61

wv Sets the current wavelength. 7-62

pw? Queries the current power reading. 7-62

pos Queries the current beam position. 7-62

tmp Queries the current thermistor ADC value. 7-62

dst Enables LaserPAD/SSIM interface data streaming. 7-62

dsp Disables LaserPAD/SSIM interface data streaming. 7-63

Data Streaming Transmission Interface Gating

INITiate Enables data streaming interface transmission. 7-64

ABORt Disables data streaming interface transmission. 7-64

Table 7-1.  Host Command Quick Reference (Sheet 4 of 4)
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• 3.1256E4

• 31.256E3

• +3.1256E+4.

Unless otherwise specified, non-numeric data items (typically referred to
as strings) are not quoted.

Enumerated values must exactly match, using the long form/short form
comparison rules defined under the SCPI Standard.

7.4.2 Commands and Queries

7.4.2.1 SCPI Common Commands 

The SCPI Standard specifies a standard set of common commands. All
common commands and queries start with an asterisk.

7.4.2.1.1 Reset Command - *RST

Resets all operational parameters to their power-on states. Reset does
not affect factory settings. Also see ’Reset Command - *RST’ (p. 45).

Command: *RST

Query: none

7.4.2.1.2 Identification Query - *IDN?

Queries the sensor identification string, such as model name, firmware
version, and firmware date.

Query: *IDN?
Reply: “Coherent, Corp – PowerMax” + <type> + “–” + <version> + “–” +
<firmware date> Note: The quotes are not transmitted.

Example reply: Coherent, Corp – PowerMax-USB – V1.3 – Jul 10 2009

7.4.2.2 System Options

The system commands and queries access functionality that is exclusive
of sensor measurement functions. These commands can be sent at any
time without affecting a measurement in progress.
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7.4.2.2.1 System Status

Queries the system status. Status is returned in a string containing one
ASCII character for each status condition that is asserted. If the status
condition character is present, the condition is asserted. If the status con-
dition character is absent, the condition is not asserted. The following ta-
ble describes the status condition character mapping.

Command: none

Query: SYSTem:STATus?
Reply: <status>

Example: If the sensor damage temperature is exceeded, the system sta-
tus query will return:

“T” note: The quotes are not transmitted.

7.4.2.2.2 Sensor Temperature

Queries the sensor temperature.

Command: none

Query: SYSTem:INFormation:TEMPerature?
Reply: <sensor temperature in degrees Celsius in integer format>

The literal string “NA” (quotes not included) is returned if the sensor does
not have a temperature measurement capability.

7.4.2.2.3 System Sync

Resets the system measurement sync timer. This query gets the system
measurement sync timer value. The system measurement sync timer is a
free-running timer that increments by one for every 1 millisecond of

Table 7-2.  Status Condition Character Definitions

Status Character Status Condition

T Damage temperature is 
exceeded

0 (zero) No status condition is 
asserted
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elapsed time. It is necessary to synchronize the measurement sync timers
of all sensors that are used for applications requiring synchronization. The
maximum value of this timer is 4294967295 milliseconds; however, to
counteract clock creep, the system sync command should be sent at inter-
vals not to exceed 10 minutes.

Command: SYSTem:SYNC

Query: SYSTem:SYNC?
Reply: <current timer value>

7.4.2.2.4 System Restore

Restores the persistent data back to the factory settings, which erases us-
er-defined settings.

Command: SYSTem:RESTore 

Query: none

7.4.2.2.5 Message Handshaking

Selects the state of SCPI message round trip handshaking.

Command: SYSTem:COMMunicate:HANDshaking {ON|OFF}
Reply: OK if ON is selected; otherwise, no reply is sent

Default is OFF.

Query: SYSTem:COMMunicate:HANDshaking?
Reply: ON|OFF

If handshaking is ON:

• Empty commands (that is, commands with only whitespace charac-
ters) reply with “OK\r\n”

• Valid commands with valid data reply with “OK\r\n”

• Valid queries with valid data reply as explicitly defined elsewhere in
this section, followed by “OK\r\n”

• Valid commands or queries which result in an error reply with
“ERR<n>\r\n”, where <n> is the error code number—see ’Error
Record Reporting and Collection’ (p. 48).

• Unrecognized commands or queries reply with “ERR100\r\n”

• Error queuing occurs, as explicitly defined elsewhere in this document

If handshaking is OFF:
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• All command and query response will behave as explicitly defined
elsewhere in this section

7.4.2.3 Error Record Reporting and Collection

Programming and system errors occasionally occur while testing or de-
bugging remote programs, and during measurement. Error strings follow
the SCPI Standard for error record definition:

<error code>,<quoted error string>

The host queries for errors in two steps:

1. The host queries for the number of error records available (N).

2. The host queries N times for the error records. 

Errors are stacked up to 20 deep. In the case of error overflow, the last er-
ror in the error list is an indication of error overflow. The possible error
strings are shown in the following table. 

 

Error -350 is raised when the error queue becomes full. Non-“Queue over-
flow” errors are replaced by “Queue overflow” errors when there is exactly
one available storage location available in the error queue. No additional
errors are added to the error queue if the error queue is full.

Error -310 is raised when the firmware detects an unexpected or unrecov-
erable error. This error condition includes unrecoverable hardware faults.

Error 100 is raised when the sensor receives an unrecognized command
or query.

Table 7-3.  Error Codes and Description Strings

Error 
Code Quoted Error String Error Description

-350 “Queue overflow” Error queue is full

-310 “System error” Unexpected/unrecoverable hardware or software 
fault

0 “No error” No error

100 “Unrecognized 
command/query”

The command or query is not recognized

101 “Invalid parameter” The command or query parameter is invalid

102 “Data error” A data error was encountered
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Error 101 is raised when the sensor receives a command or query with
one or more invalid data parameters.

Error 102 is raised when the sensor receives a command or query for
which no valid data exists.

7.4.2.3.1 Error Count Query

Queries the number of error records in the error queue at the time of the
query.

Command: none

Query: SYSTem:ERRor:COUNt?
Reply: <count of error records stored in integer format>

7.4.2.3.2 Error Query

Queries the next error record(s) in the error queue. More than one error
record may be queried using the optional <error record count> parameter,
which must be an integer value. A single error record is returned if <error
record count> is not specified. No reply is transmitted if no error records
are available.

As the sensor transmits each error record:

• The error record is permanently removed from the error queue

• The queued error record count decrements by one

Command: none

Query: SYSTem:ERRor:NEXT? [<error record count>]
Default is not applicable.
Reply: <next available error record(s)>

7.4.2.3.3 All Error Query

Queries all error records in the error queue at the time of the query. No re-
ply is transmitted if there are no error records available.

After completion of the reply transmission:

• The error queue will be empty

• The queued error record count will be zero

Command: none
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Query: SYSTem:ERRor:ALL?
Reply: <all available error record(s)>

7.4.2.3.4 All Error Clear

Clears all error records in the error queue. 

Command: SYSTem:ERRor:CLEar

Query: none

7.4.2.4 Measurement Setup and Control

7.4.2.4.1 Measurement Mode

Sets the sensor measurement mode to select either power (Watts) or en-
ergy (Joules) measurement mode. Note: Joules measurement mode is
only possible with a thermopile type power sensor.

Command: CONFigure:MEASure {DEFault|J|W}
Default is W (Watts) mode.

Query: CONFigure:MEASure?
Reply: J|W

Error 100 is raised if the sensor is an optical sensor.

7.4.2.4.2 Speedup

Sets the speedup state. The query gets the speedup state.

Command: CONFigure:SPEedup {DEFault|ON|OFF}
Default is OFF

Query: CONFigure:SPEedup?
Reply: {ON|OFF}

Error 100 is raised if the sensor is an optical sensor.

7.4.2.4.3 Wavelength

Sets the current wavelength, which is committed to persistent storage
when it is changed. If the requested wavelength is greater than the upper
wavelength limit, the current wavelength is set to the upper wavelength
limit. Likewise, if the requested wavelength is less than the lower wave-
length limit, the current wavelength is set to the lower wavelength limit. 
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The minimum and maximum allowed wavelength may also be named as
data arguments. The query gets the current maximum or minimum al-
lowed wavelengths, depending on the optional query data argument.

Command: CONFigure:WAVElength {MINimum|
MAXimum|<requested wavelength in nm>}

Query: CONFigure:WAVElength? [MINimum|
MAXimum]
Reply (if [MINimum|MAXimum] is not specified):
<granted wavelength in nm>
Reply (if MAXimum is specified):
<allowed maximum wavelength in nm> 
Reply (if MINimum is specified):
<allowed minimum wavelength in nm>

7.4.2.4.4 Gain Compensation

Enable/Disable State

Enables or disables gain compensation, which is committed to persistent
storage when it is changed. If gain compensation is enabled, power read-
ings sent over the host port will be measured power multiplied by the gain
compensation factor.

Command: CONFigure:GAIN:COMPensation {DEFault|OFF|ON}
Default is OFF

Query: CONFigure:GAIN:COMPensation?
Reply: OFF|ON

Factor

Sets the gain compensation factor, which is committed to persistent stor-
age when it is changed.

Command: CONFigure:GAIN:FACTor {DEFault|
<0.001...100000.0>}
Default is 1.0

Query: CONFigure:GAIN:FACTor?
Reply: <gain compensation factor>

7.4.2.4.5 Sensor Zero

Sets the current measurement as the zero baseline measurement. We
recommend that the sensor is set to zero prior to measuring power to null
out any offset in the power sensor. If a thermopile was recently touched or
exposed to heat, wait for the sensor to settle back to a stable zero point
before the Zero command is sent.

Command: CONFigure:ZERO
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7.4.2.4.6 Accuracy Mode

Selects the measurement accuracy mode. The available modes are pow-
er-only and power-plus-position.

Command: CONFigure:AMODe {DEFault|PONly|PPPosition}
Default is PPPosition (power plus position) mode

Query: CONFigure:AMODe?
Reply: PONLY|PPPOSITION

Error 100 is raised if the sensor is a mono or optical sensor.

7.4.2.4.7 Pulsed Thermopile Joules Trigger Level

Selects the pulsed thermopile Joules mode trigger sensitivity level. 

Command: TRIGger:PTJ:LEVel {DEFault|LOW|MEDium|HIGH}
Default is LOW

Query: TRIGger:PTJ:LEVel?
Reply: LOW|MEDIUM|HIGH

7.4.2.5 Measurement Data Record Item Select and Format

Data items that appear in a measurement data record are selectable.
Available selections differ, based on measurement mode and sensor type.

This command selects the transmit data items transmitted in non-SIMM
measurement data records—defined later in this section, and SSIM mea-
surement data records—defined under ’LaserPAD/SSIM Streaming Data
Record Format’ (p. 63). The data argument is a comma-separated list of
one or more tokens, shown below. At least one token must be specified.
The tokens may be specified in any order.

Command: CONFigure:ITEMselect {MEAS,POS,FLAG,TST}

Query: CONFigure:ITEMselect?
Reply: one or more of MEAS|POS|FLAG|TST

Measurement data records contain one or more data items and are for-
matted according to the following table. 

Table 7-4.  Non-SIMM Measurement Data Record Formats

Sensor Type Measurement Mode Last Measurement Record Format

Thermopile 
Mono

Watts <power>,<flags>,<timestamp>

Joules <energy>,<flags>,<timestamp>
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Each data item is selected for transmission using the ITEMselect com-
mand:

• <power>, expressed in Watts using the “%.5E” C formatting specifi-
cation, is transmitted when MEAS is specified

• <energy>, expressed in Joules using the “%.5E” C formatting specifi-
cation, is transmitted when MEAS is specified

• <X position> and <Y position>, expressed in mm using the “%.2E” C
formatting specification, is transmitted when POS is specified

• <flags>, enumerated in Table 5 and described below, is transmitted
when FLAG is specified

• <timestamp>, expressed in integer milliseconds, is transmitted when
TST is specified

The <flags> data item, which communicates qualification information, is
reported with each data message. Qualification information includes vari-
ous error conditions. It is reported in a string containing one ASCII charac-
ter for each qualification that is asserted. 

• If the qualification character is present, the qualification is asserted. 

• If the qualification condition character is absent, the qualification is not
asserted. 

Each character present has a unique meaning as described in the follow-
ing table.  

Thermopile 
Quad

Watts <power>,<X position>,<Y position>,<flags>,<time-
stamp>

Joules <energy>,<flags>,<timestamp>

Optical Watts <power>,<flags>,<timestamp>

Table 7-4.  Non-SIMM Measurement Data Record Formats

Sensor Type Measurement Mode Last Measurement Record Format

Table 7-5.  Flags Character Definitions (Sheet 1 of 2)

Qualification Character Qualification Meaning

R Over-range error

N Negative power
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Selecting POS for non-quad sensors has no effect on the transmission of
data records.

X and Y positions are zero if the power is less than 10% of the minimum
range—refer to ’Minimum Range Query’ (p. 60).

The data has over-range status if the power is greater than the maximum
range—refer to ’Maximum Range Query’ (p. 61).

7.4.2.6 Measurement Data Record Reading

Queries the last recorded measurement at the time of the query. No reply
is transmitted if a measurement has not been recorded.

Command: none

Query: READ?
Reply: <last measurement record>

The last measurement record is composed of comma-delimited data items
generated at the same instant. The data items presented, including a flags
item, varies, depending on the sensor type as enumerated in the following
table.  

S Measurement is sped up

T Over-temperature error

0 (zero) No qualification exists

Table 7-5.  Flags Character Definitions (Sheet 2 of 2)

Qualification Character Qualification Meaning

Table 7-6.  Measurement Data Record Formats

Sensor Type Measurement Mode Last Measurement Record Format

Thermopile Mono Watts <power>,<flags>,<timestamp>

Joules <energy>,<flags>,<timestamp>

Thermopile Quad Watts <power>,<X position>,<Y position>,<flags>,<time-
stamp>

Joules <energy>,<flags>,<timestamp>

Optical Watts <power>,<flags>,<timestamp>
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<power> will be expressed in Watts using the “%.5E” C formatting specifi-
cation.

<energy> will be expressed in Joules using the “%.5E” C formatting speci-
fication.

<X position> and <Y position> will be expressed in mm using the “%.2E”
C formatting specification.

<timestamp> will be expressed in integer milliseconds. This timestamp is
based upon the system sync function. Zero time is set when the device re-
ceives the SYSTem:SYNC command.

The <flags> data item, which communicates qualification information, is
reported with each data message. Qualification information—including
various error conditions—is reported in a string containing one ASCII
character for each qualification that is asserted. 

• If the qualification character is present, the qualification is asserted.

• If the qualification condition character is absent, the qualification is not
asserted.

Each character present has a unique meaning, as described in the follow-
ing table.  

• X and Y positions are zero if the power is less than 10% of the
minimum range.

• Data has over-range status if the power is greater than the maximum
range.

The READ? query returns a power reading, along with a flag and a time-
stamp. The power reading is in the format of X.XXXXX, followed by an ex-
ponent value. In the following example, two readings were taken:

Table 7-7.  Flags Character Definitions

Qualification Character Qualification Meaning

R Over-range error

N Negative power

S Measurement is sped up

T Over-temperature error

0 (zero) No qualification exists
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• The first power reading return is -1.53175e-03, followed by the N flag
(indicating a negative power reading—meaning the sensor has not
yet been properly zeroed), and then the timestamp (47300 ms).

• The second power reading return is -2.05320e-03, followed by the N
flag and the timestamp (53700 ms).

The READ? query separates the reading into several parts. If only a nu-
meric value for a power reading is needed, use the PW? query, which is
easier to use if you want a power reading and aren't worried about check-
ing for errors or a timestamp.

For more information about the PW? query, refer to ’Current Power Read-
ing Query’ (p. 62).

7.4.2.7 Sensor Information

The sensor can be queried for unit identification and quality control infor-
mation.

7.4.2.7.1 Serial Number

The query gets the sensor serial number.

Query: SYSTem:INFormation:SNUMber?
Reply: <quoted serial number>

7.4.2.7.2 Part Number

The query gets the part number.

Figure 7-1.  Read Query Example
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Query: SYSTem:INFormation:PNUMber?
Reply: <quoted part number>

7.4.2.7.3 Model Name

The query gets the model name.

Query: SYSTem:INFormation:MODel?
Reply: <quoted model name>

7.4.2.7.4 Calibration Date

The query gets the calibration date.

Query: SYSTem:INFormation:CDATe?
Reply: <quoted calibration date>

7.4.2.7.5 Manufacturing Date

The query gets the manufacturing date.

Query: SYSTem:INFormation:MDATe?
Reply: <quoted calibration date>

7.4.2.7.6 Sensor Type and Connection Configuration

The query gets the sensor type and connection configuration (thermopile
mono, thermopile classical quad, thermopile enhanced quad, or optical).

Query: SYSTem:INFormation:TYPE?
Reply: <type>,<qualifier>

<type> is one of THERMO or OPT.
<qualifier> is one of SINGLE, QUAD, ENHQUAD, or NOSPEC.

7.4.2.7.7 Aperture Diameter

The query gets the aperture diameter.

Query: SYSTem:INFormation:DIAMeter?
Reply: <aperture diameter in mm>
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7.4.2.7.8 Default Wavelength

The query gets the default wavelength.

Query: SYSTem:INFormation:WAVElength?
Reply: <default wavelength in nm>

7.5 Legacy LaserPAD/SSIM Interface Section

PowerMax-USB and PowerMax-RS sensors support the legacy Laser-
PAD/SSIM host command sets. This offers customers the capability of us-
ing PowerMax-USB And PowerMax-RS sensors as drop-in replacements
for their current OEM sensors. The LaserPAD/SSIM interface supports all
LaserPAD/SSIM commands, queries, and responses, except those relat-
ed to PocketPC mode.

7.5.1 Commands and Queries

Note that some LaserPAD/SSIM commands also have defined replies.

7.5.1.1 Help Query

Queries the list of LaserPAD/SSIM commands.

Query: h
Reply: 

“*rst - reset system
*ind - identify system
app - get aperture diameter
cal - get calibration date
df? - get family
dsp - stop data streaming
dst - start data streaming
dt? - get name
h - show this help
mfg - get manufacture date
pos - get x,y position in mm
pw? - get power in watts
rmi - get minimum range
rmx - get maximum range
sn? - get serial number
tmp - get thermistor reading
v? - get firmware version
vp? - get protocol version
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wl? - get default wavelength
wv <float> - set current wavelength in meters
wv? - get current wavelength in meters
spd - toggles speedup state on/off
spd? - queries the speedup state” Note: The quotes are not transmitted.

7.5.1.2 Reset Command

Resets all operational parameters to their power-on states. Reset does
not affect factory settings. Also refer to ’Reset Command - *RST’ (p. 45).

Command: *rst
Reply: none

7.5.1.3 Hardware Description Query

Queries the hardware description.

Query: *ind
Alias query: dt?
Reply: “PowerMax” + <type> Note: The quotes are not transmitted.

Example reply: PowerMax USB

7.5.1.4 Firmware Version Query

Queries the firmware version.

Query: v?
Reply: <the firmware version string>

7.5.1.5 Data Stream Protocol Version Query

Queries the data stream protocol version.

Query: vp?
Reply: “v.12.10.03” Note: The quotes are not transmitted.

7.5.1.6 Serial Number Query

Queries the serial number.
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Query: msn?
Alias query: sn?
Reply: <serial number>

7.5.1.7 Calibration Date Query

Queries the calibration date.

Query: mcal?
Alias queries: cal and cal?
Reply: <calibration date>

7.5.1.8 Manufacturing Date Query

Queries the manufacturing date.

Query: mfg
Alias query: mmfg?
Reply: <manufacturing date>

7.5.1.9 Sensor Family Query

Queries the sensor family.

Query: df?
Reply: {“thermal”|“quantum”} Note: The quotes are not transmitted.

7.5.1.10 Aperture Diameter Query

Queries the aperture diameter, a fixed value.

Query: app
Reply: <aperture diameter in mm>

7.5.1.11 Minimum Range Query

Queries the minimum range.

Query: rmi
Reply: <minimum allowed power measurement in watts>
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7.5.1.12 Maximum Range Query

Queries the maximum range.

Query: rmx
Reply: <maximum allowed power measurement in watts>

7.5.1.13 Speedup State Query

Queries the speedup state.

Query: spd?
Reply: {“on”|“off”} Note: The quotes are not transmitted.

7.5.1.14 Speedup State Toggle Command

Toggles the speedup state. If the speedup state is ON, sending the com-
mand turns speedup OFF, and vice versa.

Command: spd
Reply: {“speedup threshholding is on.”|“speedup threshholding is off.”}
Note: The quotes are not transmitted.

7.5.1.15 Default Wavelength Query

Queries the default wavelength.

Query: wl?
Reply: <default wavelength in meters>

7.5.1.16 Current Wavelength Query

Queries the current wavelength.

Query: wv?
Reply: <current wavelength in meters>
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7.5.1.17 Current Wavelength Command

Sets the current wavelength, which is committed to persistent storage
when it is changed. If the requested wavelength is greater than the upper
wavelength limit, the requested wavelength is set to the upper wavelength
limit. Likewise, if the requested wavelength is less than the lower wave-
length limit, the requested wavelength is set to the lower wavelength limit.

Command: wv <requested wavelength in meters>
Reply: <granted wavelength in meters>

7.5.1.18 Current Power Reading Query

Queries the current power reading.

Query: pw?
Reply: <current power reading in watts>

7.5.1.19 Current Beam Position Query

Queries the current beam position. If the sensor is an optical sensor, the
returned position X and Y values are 0.

Query: pos
Reply (thermopile quad sensor): <X position in mm>,<Y position in mm>
Reply (thermopile mono or optical sensor): 0,0

Note that X and Y positions are zero if the sensor is a thermopile mono or
if the power is less than 10% of the minimum range—see ’Minimum
Range Query’ (p. 60).

7.5.1.20 Current Thermistor Counts Query

Queries the current thermistor ADC value.

Query: tmp
Reply: <thermistor integer ADC counts>

7.5.1.21 Start Data Streaming Command

Enables LaserPAD/SSIM mode interface data streaming. Streaming data
records are transmitted at 10 Hz. Streaming data records continue to be
transmitted until the Stop Data Streaming command (see below) is issued.
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Command: dst
Reply: none

7.5.1.22 Stop Data Streaming Command

Disables LaserPAD/SSIM mode interface data streaming.

Command: dsp
Reply: none

7.5.2 LaserPAD/SSIM Streaming Data Record Format

The LaserPAD/SSIM mode streaming data record format is different for
thermopile and optical sensors, as shown in the following table.  

The asterisk is literal.

X and Y position are zero if the sensor is a thermopile mono or if the pow-
er is less than 10% of the minimum range—see ’Minimum Range Query’
(p. 60).

The data has over-range status if the power is greater than the maximum
range—see ’Maximum Range Query’ (p. 61).

Each data item is selected for transmission using the ITEMselect com-
mand—see ’Measurement Data Record Item Select and Format’ (p. 52):

• <power in Watts>, expressed in Watts using the “%.3e” C formatting
specification, is transmitted when MEAS is specified

• <X position in mm> and <Y position in mm>, expressed in mm using
the “%.2e” C formatting specification, is transmitted when POS is
specified

• <status code> (described below) is transmitted when FLAG is speci-
fied

Table 7-8.  Measurement Data Record Formats

Sensor 
Type Last Measurement Record Format

Thermopile *<X position in mm>,<Y position in mm>,<power in Watts>,<status 
code>

Optical *<power in Watts>,<status code>
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Status code:

c = Measurement data is valid

r = Measurement is over-range

t = Sensor temperature exceeds the damage temperature

7.6 Data Streaming Transmission Interface Gating 
Section

The data streaming transmission interface should not be confused with
legacy LaserPAD/SSIM mode interface data streaming. Gating of the data
streaming transmission is controlled by the INITiate and ABORt com-
mands (described under “Initiate Command” and “Abort Command” be-
low).

7.6.1 Streaming Measurement Data

In data streaming mode, the host has control over when measurement
data is transmitted from the data streaming transmission interface. 

Transmission is enabled after an INITiate command and disabled after an
ABORt command. 

When transmission is enabled, measurement data records are transmitted
immediately as they are generated.

7.6.2 Commands and Queries

7.6.2.0.1 Initiate Command

Enables data streaming interface transmission. This command is ignored
if data streaming interface transmission is already enabled.

Command: INITiate

Query: none

7.6.2.0.2 Abort Command

Disables data streaming interface transmission. This command is ignored
if data streaming interface transmission is already disabled.
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Command: ABORt

Query: none

Data streaming transmission messages are ASCII formatted, but not
strictly so. The high bit (mask 0x80) is always set for all bytes of all data
streaming transmission messages, including the terminators. This allows
host software to easily differentiate between data streaming transmission
messages and LaserPAD/SSIM and SCPI reply messages. The host may
operate using the rule that if the high bit is set on any byte received from
the sensor, it is part of a data streaming transmission message.

Data streaming transmission messages are immediately sent to the host
in ASCII text form as measurements are generated (see Table 7-9, be-
low). Each message conforms to the last measurement data record format
but with the high bit set in all transmitted bytes. 

7.7 Operational Parameters

All operational parameters—except the current wavelength, gain compen-
sation factor, and gain compensation state—are not persistent after a re-
set cycle. The following table shows all operational parameters. 

Table 7-9.  Data Streaming Transmission Rates

Sensor 
Type Measurement Mode Transmission Rate

Thermopile Watts Continuously at 10 Hz

Thermopile Joules When pulse energy is calcu-
lated

Optical Watts Continuously at 10 Hz

Table 7-10.  Operational Parameters (Sheet 1 of 2)

Parameter Power-on State

Speedup state Off

Measure Mode Watts

Error count 0

LaserPAD/SSIM data streaming state Stopped/Disabled

Data streaming transmission interface state Stopped/Disabled
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7.8 RS-232 Port Settings

The PowerMax-RS sensors communicate over an RS-232 port using the
RS-232 settings shown in the following table.  

Sync 0

SCPI handshaking Off

Zero Factory setting

Pulsed thermopile Joules mode trigger sensi-
tivity level

Low

Accuracy mode Power-plus-position

Current wavelength (persistent) Last granted setting

Gain compensation factor (persistent) Last setting

Gain compensation state (persistent) Last setting

Wavelength correction cursor 0/start

Temperature compensation cursor 0/start

Power compensation cursor 0/start

Table 7-10.  Operational Parameters (Sheet 2 of 2)

Parameter Power-on State

Table 7-11.  RS-232 Port Settings

Parameter Setting

Baud rate 9600

Data bits 8

Parity None

Stop bits 1

Flow control None
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8 Calibration, Warranty and 
Service

In this section provides information on calibration, warranty, service, and
product shipment instructions.

8.1 Calibration

Coherent laser power and energy meters are precision instruments, capa-
ble of delivering very accurate measurements, as well as providing many
years of useful service. To maintain this high level of performance, it is im-
portant to have measurement systems serviced and re-calibrated once a
year.

A large percentage of Coherent calibrations are performed within five
business days, and expedited service is available, to minimize customer
downtime.

8.1.1 Scope of Calibration

Calibration of a Coherent power and energy laser measurement product
includes:

• Calibration to original uncertainty levels

• Minor repairs (see more information, below)

• Extended 12 month warranty, on eligible products

• Fast calibration turn around time.

Minor repairs includes fixing manufacturer’s defects, hardware updates,
firmware, software updates, damaged connectors, and other small repairs.
Detector element replacement due to laser damage and damage caused
by negligent use is not covered – for customer caused damaged an addi-
tional repair service charge is applied.

This level of service results in an overall lower cost of ownership, with
many owners realizing a lifetime warranty for their products.
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8.1.2 Re-certify Once a Year

Coherent laser power and energy meters are precision instruments, capa-
ble of delivering very accurate measurements as well as providing many
years of useful service. To maintain this high level of performance, and to
ensure compliance with your quality and ISO certification, it is important to
have measurement systems serviced and re-certified once per year.

Extended use of laser power and energy meters and sensors, as well as
environmental factors, can have an adverse effect on accuracy and also
result in wear and/or damage to parts critical to optimum performance.

8.1.3 Coherent Calibration Facilities and Capabilities: ISO 17025 
Accredited

Coherent calibration facilities contain the widest possible range of light
sources from 193 nm to 10,600 nm, with powers ranging nanowatts to
kilowatts. 

Coherent Wilsonville, Oregon, and its satellite sites, are fully accredited to
ISO/IEC 17025:2017 by ANAB - The ANSI National Accreditation Board.
ANAB is a signatory of the International Accreditation Forum (IAF) and In-
ternational Laboratory Accreditation Cooperation (ILAC) multilateral rec-
ognition arrangements. ANAB has signed the MRAs of the InterAmerican
Accreditation Cooperation (IAAC) and the Asia Pacific Accreditation Coop-
eration (APAC). Accreditation to ISO/IEC 17025 is the formal recognition
that a calibration laboratory is technically competent to carry out specific
calibrations.

A detailed discussion of the Scope of Accreditation and the Technical Re-
quirements of ISO 17025 Accreditation can be found on the Coherent ISO
17025:2017 Accreditation web page. 

In addition, Coherent team delivers the industry's best service, with a
knowledgeable and responsive staff, and rapid turnaround.

8.2 Warranty

8.2.1 Limited Warranty

Coherent, Corp. (the “Company”) warrants its laser power and energy me-
ters and sensors products (“Products”) to the original purchaser (the “Cus-
tomer”) that the product is free from defects in materials and workmanship
and complies with all specifications, active at the time of purchase, for a
period of twelve (12) months.
68



Calibration, Warranty and Service 
Coherent, Corp. will, at its option, repair or replace any product or compo-
nent found to be defective during the warranty period. This warranty ap-
plies only to the original purchaser and is not transferable.

8.2.2 Warranty Limitations

The foregoing warranties shall not apply, and Coherent reserves the right
to refuse warranty service, should malfunction or failure result from:

• Damage caused by improper installation, handling or use.

• Laser damage (including sensor elements damaged beyond repair).

• Failure to follow recommended maintenance procedures.

• Unauthorized product modification or repair.

• Operation outside the environmental specifications of the product.

Coherent assumes no liability for Customer-supplied material returned
with Products for warranty service or recalibration. 

THIS WARRANTY IS EXCLUSIVE IN LIEU OF ALL OTHER WARRAN-
TIES WHETHER WRITTEN, ORAL, OR IMPLIED. COHERENT SPECIFI-
CALLY DISCLAIMS THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN
NO EVENT SHALL THE COMPANY BE LIABLE FOR ANY INDIRECT, IN-
CIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH
ITS PRODUCTS.

8.3 Extended Warranty Program

Coherent, Corp. (the “Company”) offers original purchasers (the “Custom-
er”) purchasing laser power and energy meters and sensors products
(“Products”) an extended twelve (12) month warranty program, which in-
cludes all parts and labor. In order to qualify for this warranty, a Customer
must return the Product to the Company for recalibration and recertifica-
tion. 

• The Company will re-certify the Product, provide software upgrades,
and perform any needed repairs, and recalibrate the Product, for a
fixed service fee (as established by the Company from time to time
and in effect at the time of service). 

• If the product cannot be re-certified due to damage beyond repair,
parts obsolescence, or other reasons, the Customer may be informed
that an Extended Warranty program is not available for the Product.
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If the Product fails and is returned to the Company within one year follow-
ing the date of recalibration and recertification service, the Company will,
at its option, repair or replace the Product or any component found to be
defective. If the Product must be replaced and the Product is no longer
available for sale, Coherent reserves the right to replace with an equiva-
lent or better Product. This warranty applies only to the original purchaser
and is not transferable.

8.4 Obtain Service

In order to obtain service under this warranty, the Customer must notify
the Company of the defect before the expiration of the warranty period
and make suitable arrangements for the performance of service. The
Company shall, in its sole discretion, determine whether to perform war-
ranty service at the Customer's facility, at the Company's facility or at an
authorized repair station.

If Customer is directed by the Company to ship the product to the Compa-
ny or a repair station, Customer shall:

Package the product (to protect from damage during shipping).

Ship it to the address specified by the Company, shipping prepaid. The
customer shall pay the cost of shipping the Product back to the Customer
in conjunction with recalibration and recertification.

The Company shall pay the cost of shipping the Product back to the Cus-
tomer in conjunction with product failures within the first twelve (12)
months from time of sale or during an extended 12-month warranty period.

8.5 Product Shipment Instructions

A Returned Material Authorization number (RMA) assigned by the Com-
pany must be included on the outside of all shipping packages and con-
tainers. Items returned without an RMA number are subject to return to
the sender.
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To prepare the product for shipping to Coherent:

1. Contact Coherent Customer Service (refer to Table 8-1, above) for a
Return Material Authorization number.

2. Attach a tag to the product that includes the name and address of the
owner, the person to contact, the serial number, and the RMA number
that was received from Coherent Customer Service.

3. Wrap the product with polyethylene sheeting or equivalent material.

4. If the original packing material and carton are not available:

a.) Locate a corrugated cardboard shipping carton with inside
dimensions that are at least 6 in. (15 cm) taller, wider, and
deeper than the product. The shipping carton must be
constructed of cardboard with a minimum of 375 lb. (170 kg) test
strength. 

b.) Cushion the instrument in the shipping carton with packing
material or urethane foam on all sides between the carton and
the product. Allow 3 in. (7.5 cm) on all sides, top, and bottom.

5. Make a seal on the shipping carton with shipping tape or an industrial
stapler.

Add the RMA number received from Coherent Customer Service to
the shipping label on the outside of the box.

Ship the product to one of the following repair and calibration facilities:

USA
Coherent Laser Measurement and Control Service Center
Attn: (your RMA number)
27650 SW 95th Avenue
Wilsonville, OR 97070

Table 8-1.  Coherent Service Centers

Location Phone Fax E-mail

USA 1–(800)–367–7890 503-454-5777 Customer.Support@coherent.com
or
LSMservice@Coherent.comEurope Germany: 

+49–6071–968–0
Japan: 

+813–5635–8680

+49-6071-968-499

International +1–(408)–764–4983 503-454-5777
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Europe 
Coherent Shared Services B.V.
Dieselstr. 5 b 
D-64807 Dieburg
Germany 

Asia
Coherent, Inc. Japan 
Atsugi Technical Center 
Toda 1042-4
Atsugi, Kanagawa Prefecture 
243-0023, Japan
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Appendix A: Specifications

For an up-to-date list of all compatible sensors and their specifications,
visit our website: www.Coherent.com/LMC.
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Appendix B: Troubleshooting and Error 
Messages

B.1 The PC application crashes or is forced to quit.

If the application crashes or is forced to quit, PowerMax sensors
connected to the computer may not properly release from remote
mode.

To clear the error: Disconnect and then reconnect the USB cable on
each of the affected sensors.

B.2 An error message displays when the last sensor is 
removed.

The PC application displays a communications error if all PowerMax
sensors are removed from the computer while the application is
running. This error message operates as a reminder that there are no
sensors available for data collection.

To clear the error: Select OK in the error window(s). Reconnect the
sensor to the computer and then click the Select Sensor button to
continue.

B.3 An error message displays when a sensor is removed 
while acquiring data.

The PC application displays error windows if a sensor is removed
while that sensor is streaming data. Data collection must be stopped
before removing a sensor that is being used to collect data.

To clear the error: Click OK in the error window(s). Reconnect the
sensor to the computer and then click the Select Sensor button to
continue; or, select File > Exit, to exit the software.
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B.4 Failed communications error.

The application displays an error if a communications failure occurs
while reading sensor parameters.

To clear the error: Click the OK button.
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Appendix C: Operation with PowerMax PC

In this section mini tutorials are given for setup of PowerMax RS and Pow-
erMax USB sensors. It also shows how to take a basic power measure-
ment and provides an explanation of the PowerMax PC software
functions. Topics include:

• ’Take a Power Measurement’ (p. 77)

• ’Understand and Use the PowerMax PC Software’ (p. 82)

C.1 Install the Software

Install the PowerMax PC software (for complete installation instructions,
refer to the ’Software Installation’ section of the PowerMax-USB/RS Soft-
ware Installation and Quick Start Guide—P/N 1169931——that shipped
with a system).

C.2 Take a Power Measurement

This section shows two ’mini-tutorials’ that tell how to connect a Power-
Max-USB or PowerMax-RS sensor to a PC and start taking measure-
ments with the PowerMax PC software.

For instructions about communicating with the sensor directly through
host commands, refer to ’Host Interface’ (p. 39).

Tutorials include:

• Measure power with a PowerMax-USB thermopile sensor (p. 78).

• Measure power with a PowerMax-RS thermopile sensor (p. 79).

WARNING!
Follow all laser safety procedures. The laser must be switched OFF or
shuttered before running the tutorials given in this section.
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C.2.1 Measure Power With a PowerMax-USB Thermopile Sensor

This quickstart tutorial describes how to take a power measurement with a
PowerMax-USB thermopile sensor and PowerMax PC software.

WARNING!
Confirm the laser is set to OFF or shuttered before starting this tuto-
rial.

1. Attach the PowerMax-USB sensor to
the PC.

2. Make sure that the blue LEDs on the
USB connector are come on and slowly
ramping up and down in intensity (which
signifies the sensor is operating and the
driver is correctly loaded).

3. Start the PowerMax PC software.

4. Select the sensor serial number from
the Select Sensor drop-down menu.
In the example at right, the selected
sensor serial number is 0747K09R.

5. Press the Zero Sensor button to
zero out any offset in the sensor.

6. Press the Start Data Collection
button and then set the laser to ON to
start taking power measurements.

Blue LED

Blue LED
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C.2.2 Measure Power With a PowerMax-RS Thermopile Sensor

Note the following:

This quickstart tutorial shows how to get a power measurement with a
PowerMax-RS thermopile sensor and the use of PowerMax PC software. 

Note that the PowerMax-RS sensor is powered by a +5 VDC power sup-
ply input.Refer to Figure C-1.

WARNING!
Make sure that the laser is set to OFF or shuttered before starting this
tutorial.

Figure C-1.  Power Supply for the PowerMax-RS Sensor

Power
supply

Sensor
power cable
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1. Plug the PowerMax-RS sensor into
an available RS-232 COM port on
the computer.

2. Attach the +5VDC power supply
cable into the sensor power cable and
the power supply into a wall electrical
outlet. NOTE: The power
supply—P/N 1105557— is available
from Coherent as an optional accessory. 

3. Make sure that the blue LEDs on the RS
connector come on and slowly go up and down
in intensity (which signifies the sensor is
working). 

4. Start the PowerMax PC software.

5. Click Add RS-232/Serial Sensor
from the Settings drop-down menu.

6. From the Add Serial Sensor screen,
select the COM port to which the
PowerMax-RS sensor is attached.
The COM port number is automati-
cally determined by the computer.
(If needed, check in Device
Manager for available COM ports.)
In this example, the selected COM port is 2.

When the COM port is selected, 
the PowerMax PC software 
scans that port and identifies the 
connected sensor. 

As long as the sensor is correctly 
connected and power is supplied 
up, the serial number of the sensor is available for selection 
from the drop-down menu in the software. In this example, the 
connected sensor is 0341I09R. 

Sensor power cable

Power supply 

Blue LEDs 
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7. Put the sensor into the beam path, making sure the laser is sett OFF
or shuttered until the sensor is set to zero.

8. Click the Zero Sensor button to
zero out any offset in the sensor.

9. Click the Start Data Collection
button

10. Set the Laser to ON to start to take
power measurements.
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C.3 Understand and Use the PowerMax PC Software

C.3.1 Overview

C.3.1.1 Front Panel

The Front panel is the first screen that appears when the software is start-
ed. From here, enter parameters, select modes, change ranges, start/stop
data acquisition, and view the output in a chart format. 

Each function accessed through the Front panel is discussed, starting
next.

C.3.1.2 Keyboard Shortcuts

The following table shows available shortcuts for several standard func-
tions:  

Table C-1.  Keyboard Shortcuts

Function Shortcut

Exit program <Ctrl>+<Q>

Open new Front panel <Ctrl>+<N>

Print window <Ctrl>+<P>
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C.4 Common Functions

C.4.1 Select Sensor

Shows all the connected PowerMax sensors that can be selected for use
by the current Front panel.

The serial numbers of all attached PowerMax sensors are shown in the
drop-down menu, with the visible serial number indicating which sensor is
the current data source.

C.4.1.1 Notes:

• After attaching a sensor, it can take several seconds for the serial
number to appear on the list.

• Sensors connected to a computer but already controlled by a Front
panel will appear grayed out (not selectable) in the Select Sensor
drop-down list. If a sensor is de-selected in a Front panel, the Select
Sensor drop-down list automatically updates and that sensor will then
be available for selection.

Show context help <Ctrl>+<H>

View full application <Ctrl>+<F>

View saved data file <Ctrl>+<V>

Table C-1.  Keyboard Shortcuts

Function Shortcut
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• By default, RS-232 ports do not automatically appear on this
drop-down menu. For information about selecting a RS-232 port, refer
to ’Add RS-232/Serial Sensor’ (p. 116). 

C.4.2 Start/Stop Data Collection

Enables/disables sample collection, including:

• The Trending chart

• Synchronized trending, if enabled

• The Histogram chart

• The Tuning chart

• The Live Reading indicator

• All statistic indicators

• Data logging, if active 
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C.4.3 Zero the Sensor

Press of the Zero button starts the Zero function and sets the current sen-
sor input as the baseline for future measurements. It is recommended that
to set the sensor to zero after first turning it on and before starting any
new set of power measurements.

When a zero procedure is in process, no other button events are queued
or started until the procedure ends. The zero procedure immediately stops
if the sensor is disconnected or if an error happens.

Normally, the Zero button must be pressed while the laser is turned off, or
while the laser beam is blocked. If a finite power level is present at the
sensor, the instrumentation will try to null it out.

The sensor can only zero a finite level of offset equivalent to approximate-
ly 10% of full scale range.

NOTICE
If set to zero is not successful—which means the power input is too
large to null—set to zero again in a more stable environment or select
a different range.
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C.4.4 Set the Wavelength

The wavelength must always be set for accurate power measurements.
This can be done either in the PowerMax PC application software or over
the host port via a host command.

C.4.5 Trending Chart

Displays the data received from the PowerMax sensor.  

The axis scale points—(x) and (y)—can be directly edited by clicking on
them and entering the desired value. Example: Clicking on the first x-axis
point and setting it to 0 (zero) displays the data from beginning to present.

C.4.5.1 Autoscale

• Checked: Y-axis Autoscale is active.

• Unchecked: The graph displays the y-axis in fixed scale.

C.4.6 Histogram Chart

Displays a histogram of measurement values in the sample buffer.

Autoscale
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The sample buffer is controlled by the Sample Size. For example, with a
sample size of 100, up to 100 samples are used in the histogram. When
more than 100 samples have been collected, only the 100 most recent
samples are displayed.

C.4.6.1 Number of Bins

Sets the number of bins along the x-axis used to plot the histogram data. 

C.4.7 Tuning Chart

Displays two values on the Tuning meter:

• Green pointer = current measurement value (also displayed as a
value in the Current Value window at the bottom left of the Tuning
chart)

• Red pointer = maximum measured value (also displayed as a value
in the Maximum window at the bottom right of the Tuning chart)

C.4.8 Tuning Scale

Use this button to select the scaling range of the Tuning meter.

Number
of Bins
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• Min - Max: Sets the low end of the scale range to the minimum value
in the current data set and the high end of the scale range to the
highest value measured since the last reset.

• Zero - Max: Sets the low end of the scale to zero and the high end of
the scale to the highest value measured since the last reset.

C.4.8.1 Reset Maximum Button

Click to reset the maximum value.

C.4.9 Alignment Target Chart

(Position-sensing thermopile sensors only)

The target represents the bull's-eye view of the laser beam position of the
selected sensor. Position values are scaled and the outer ring refers to the
aperture radius.

The dot on the target represents the position of the beam on the surface of
the sensor. As the beam nears the edge of the aperture, the dot will dis-
play near the edge of the bull's-eye. This feature is useful when setting up
the sensor for a measurement, especially with non-visible laser beams.

NOTICE
The Alignment Target tab only appears if a thermopile quad sensor is
selected as the current data source.

Tuning
Scale

Reset
Maximum
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C.4.10 Synchronized Trending Chart

When multiple sensors are available, this tab provides synchronized plot-
ting of two sensors on the same chart. This screen also provides the op-
tion of performing math—such as ratiometry (A/B)—with use of two
sensors.

NOTICE
The Synchronized Trending tab only appears if two PowerMax-USB
sensors are available for control by the application. If two sensors are
connected—and two windows open—the Synchronized Trending tab
will not be visible until one of the two windows is closed.

C.4.10.1 Numerical Indicators

These numerical indicators display the latest readout of both sensors (in
Watts, Joules, or dBm, depending on measurement mode), as well as the
optional synchronized calculated math value, if synchronized data collec-
tion is enabled.

Numerical
Indicators

Setup
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C.4.10.2 Set-Up Button

Clicking the Setup button displays the following screen: 

Options on this screen include:

• Selecting/de-selecting the second sensor to be used for synchronized
data collection

• Changing the Synchronization Calculation equation.

C.4.10.3 Sensor 1 (a)

Shows the serial number of the primary PowerMax sensor in use by the
current Front panel.

C.4.10.4 Sensor 2 (b)

The drop-down menu that appears when the Select Sensor button is
clicked shows all the connected PowerMax sensors that can be selected
for synchronized trending use by the current Front panel.

• (USB sensors) The serial numbers of all available attached
PowerMax USB sensors are shown in the drop-down menu.

• (RS sensors) RS-232 sensors will not appear in the drop-down menu
because RS-232 sensors do not support synchronized data collec-
tion.

C.4.10.5 Notes

• After attaching a sensor, it can take several seconds for the
serial number to appear on the list.
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• Sensors connected to a computer but already controlled by a
Front panel will not appear in the Sensor 2 (b) drop-down list. If
a sensor is de-selected in a Front panel, the Sensor 2 (b)
drop-down list automatically updates and that sensor will then
be available for selection.

C.4.10.6 Synchronization Calculation

Displays the current formula used for math calculation on synchronized
data. To change the formula, type the new formula into the Synchroniza-
tion Calculation field—use the letter ‘a’ to reference Sensor 1 and letter ‘b’
to reference Sensor 2. An error dialog appears if an invalid formula is en-
tered.

C.4.10.7 Zero Sensor 1 Button

Click the Zero Sensor 1 button to zero the main sensor. Clicking on this
button has the same effect as clicking on the main Zero Sensor button.

C.4.10.8 Zero Sensor 2 Button

Click the Zero Sensor 2 button to set the second, synchronized sensor to
zero.

Zero Sensor 2Zero Sensor 1
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C.4.11 Large Display Chart

NOTICE
For information about displaying the Large Display Chart in a sepa-
rate window that can be repositioned, refer to ’Show Large Format
Display’ (p. 120).
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C.4.11.1 Graph Palette

Lets a user to zoom or move the plot displayed in the Trending chart.

C.4.11.1.1 Zoom Button

Click the Zoom  button and then click an option button from the
drop-down list to do any of the following actions:  

Move

Zoom

Drag the mouse to define the rectangular plot area that will 
be displayed in the chart.

Drag the mouse to define the horizontal plot area that will 
be displayed in the chart.

Drag the mouse to define the vertical plot area that will be 
displayed in the chart.

Click this button to display all data points that have been 
collected.

Click this button and then click anywhere on the chart to 
zoom in.

Click this button and then click anywhere on the chart to 
zoom out.
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C.4.11.1.2 Move Button 

Click the Move  button and then drag the mouse on the screen to
move the plot in any direction.

C.4.11.1.3 (undefined) Button 

This button is not used at this time.

C.4.12 Data Collection Screen Elements

C.4.12.1 Live Reading

Displays the current sensor reading, if Live Data Averaging is set to 1
point. If Live Data Averaging is set to n points, the Reading indicator dis-
plays the average of the last n points.

C.4.12.2 Wavelength

The Wavelength field is used to configure the sensor to automatically ac-
count for spectral responsivity differences between the laser wavelength
and the calibration wavelength. Use this field to enter the needed laser
wavelength.

• Units can be changed by clicking the units drop-down menu (next to
the wavelength) and selecting nm or µm.
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• If a wavelength outside the permitted range is requested, the nearest
minimum value or maximum value will be entered and displayed. 

C.4.12.3 Live Data Averaging

Enables averaging of the last n data points for the power/energy and plot
displays. This is computed as a moving average.

n can be set from 0-to-60 seconds and 2-to-1000 pulses, depending upon
the mode of operation.
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C.4.12.3.1 Notes

• Live data averaging is always in points, with 10 points per second in
Power mode, and arbitrary points per second in Pulsed Joules mode.

• With optical sensors, live data averaging is always in Power mode
with 10 points per second.

C.4.12.4 Mean

Displays the mean of the last n Sample Size samples. The value updates
as new samples are acquired. A sample size of 100 will display the stats
on two samples, then three, and continue to the nth sample. If the software
is in Continuous mode, the statistics will continue to update, using the last
n samples. In Fixed mode, the statistics will hold after the nth sample.
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C.4.12.5 Minimum (Min)

Displays the minimum value in the last n Sample Size samples. The value
updates as new samples are acquired. Example: A sample size of 100 will
display the stats on two samples, then three samples, and continue to the
nth sample. If the software is in Continuous mode, the statistics will contin-
ue to update, using the last n samples. In Fixed mode, the statistics will
hold after the nth sample. Refer to the figure below.

C.4.12.6 Counts

Displays the number of measurements taken in the current data set. Press
the Reset button to reset the counter.

• In Fixed Sample Collection mode, the Counts field increments until
the batch has the number of samples entered in the Sample Size field.
At this point, the statistics and the Trending chart will stop updating.

• In Continuous Sample Collection mode, the Counts field continues
incrementing indefinitely as more samples are collected in the batch
and plotted in the Trending chart. Even though the Counts field
continues to increment, the statistics parameters themselves are
calculated from the last n number of samples, and the Trending chart
displays the last n number of samples, where n is the number of
samples entered in the Sample Size field.
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C.4.12.7 Standard Deviation (Std Dev)

Displays the Standard Deviation of the last n Sample Size samples. The
value updates as new samples are acquired. Example: A sample size of
100 will display the stats on two samples, then three samples, and contin-
ue to the nth sample.

• If the software is in Continuous mode, the statistics will continue to
update, using the last n samples.

• In Fixed mode, the statistics will hold after the nth sample.
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C.4.12.8 Maximum (Max)

Displays the maximum value in the last n Sample Size samples. The val-
ue updates as new samples are acquired. Example: A sample size of 100
will display the stats on two samples, then three samples, and continue to
the nth sample.

• If the software is in Continuous mode, the statistics will continue to
update, using the last n samples.

• In Fixed mode, the statistics will hold after the nth sample. 

C.4.12.9 Area

The area entered in this field is used to calculate power density in Watts
per square centimeter (W/cm2). The power density reading is displayed in
the Live Reading area when Mode is set to Power/cm2.
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C.4.12.10 Zero Sensor

Zeroes the PowerMax sensor.
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C.4.12.11 Sample Collection

Selects the logging/plotting mode:

• Fixed takes and plots the number of data points shown in the Sample
Size and holds the results after the nth sample.

• Continuous takes continuous data and plots the number of data points
shown in the Sample Size in the chart window. The newest data
continuously scrolls in the window.

• The default sample rate for all PowerMax-USB and PowerMax-RS
sensors is 10 samples per second. To use a different sample rate,
change the Collection Interval.
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C.4.12.12 Mode

Selects the measurement mode: Energy (J), Power (W), Power/dBm, or
Power/cm2.

• Energy refers to a special “long-pulse joules” mode with a thermopile
sensor in which the energy in a single long-pulse greater than 1 msec
can be integrated by the thermopile sensor to calculate and display
the energy in the pulse.

C.4.12.13 Sample Size

Selects the sample size to collect when in Fixed mode, and the sample
size to use for statistics when in either Fixed or Continuous mode. Select
Use Time Base Sample to change the sample size units to seconds.
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C.4.12.14 Reset

Clicking the Reset button:

• Resets the data set used for statistics (Mean, Min, Max, and Std Dev).

• Resets Counts to 1.

• Clears Trending and other charts.
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C.4.12.15 Reset Error

A separate error dialog window appears when a user action creates an er-
ror. This window will list the possible cause of the error, as well as other in-
formation. Here is an example:

NOTICE
The OK button must be clicked in the error dialog window before new
commands are accepted.

C.4.12.16 Gain Correction

Enables/disables Gain Correction.

• Default value: Off

• Range: On (True), Off (False)
104



Operation with PowerMax PC 
• When Gain Correction is enabled, measurements taken by the sensor
will be multiplied by the Gain Correction Factor, described below.

C.4.12.16.1 Gain Correction Factor

Sets the gain correction factor stored in the PowerMax sensor.

• Default Value: 1.0

• Range: 0.001 to 100000.0

The Gain Correction Factor control indicates the current gain correction
factor stored in the PowerMax sensor. To change this setting, enter the
desired factor into the Gain Correction Factor dialog box. This factor is not
applied unless Gain Correction is enabled.

C.4.12.17 Collection Mode

Selects between Time Interval (data acquisition on a fixed-time interval)
and Streaming (continuous data acquisition).

Gain Correction
Factor
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NOTICE
Changing between Time Interval and Streaming collection modes
during data collection automatically clears the data plot display and
the statistics batch. Clearing the plot display and statistics batch is
done to prevent mixing of data sets with two different time bases.
When set to Streaming, the collection interval is automatically set to
0.1 seconds.

C.4.12.18 Collection Interval

Sets the collection interval (seconds, minutes, or hours) when Collection
Mode is set to Time Interval. This control is grayed-out when Collection
Mode is set to Streaming.
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C.4.12.19 Log Data to File

Enables/disables saving currently-acquired data to the Log Data file:

• If the Collection mode is Time Interval, data is logged to the Log Data
file at the interval specified under Collection Interval.

• If the Collection mode is Streaming, all data is logged to the Log Data
file.
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C.4.12.20 Log Data File

Shows the file currently used to log data. The file is saved in either ‘csv’
(Comma-Separated Values) format—which can be automatically opened
in Excel by double-clicking on the file name—or ‘txt’ format (a standard
text file). To view a previously-saved data file, select View Saved Data File
from the File menu.

NOTICE
Each time the Log Data to File button is toggled, the number added to
the file name is automatically incremented to prevent accidentally
overwriting of data.
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C.4.13 Menus

Five drop-down menus appear on the PowerMax PC Front panel, de-
scribed in this section: File, Settings, View, Window, and Help.

C.4.14 File Menu

Options available under the File menu:

• View a previously-saved data file (shortcut: <Ctrl>+<V>): ’View
Saved Data File’ (p. 110)

• Open a new Front panel (shortcut: <Ctrl>+<N>): ’Open New Front
Panel’ (p. 112)

• Print the current window (shortcut: <Ctrl>+<P>): ’Print Window’
(p. 113)

• Print the current graph or chart: ’Print Graph/Chart’ (p. 113)
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• Exit the program (shortcut: <Ctrl>+<Q>): ’Exit’ (p. 113)

C.4.14.1 View Saved Data File

To view information previously saved in a data file:

1. Click View Saved Data File (shortcut: <Ctrl>+<V>) from the File
drop-down menu:  

A menu similar to the following displays:
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2. Select the name of the file to view, and then click Read to display a
chart that has all the saved data. Here is an example chart: 
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C.4.14.2 Open New Front Panel

The purpose of opening a new Front panel is to control, monitor, and si-
multaneously log data—from multiple sensors—to separate files. This is
good for burn-in stations, where it is necessary to collect data from several
lasers at the same time by running several PowerMax sensors on one PC.

NOTICE
A sensor cannot be active in more than one Front panel at a time.

To open a new panel, click Open New Front Panel (shortcut: <Ctrl>+<N>)
from the File drop-down menu:

Here is an example of data from two sensors, each displayed within its
own Front panel:
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C.4.14.3 Print Window

Selecting Print Window (shortcut: <Ctrl>+<P>) from the File drop-down
menu prints the entire active window—including graphs and charts—ex-
actly as it appears on the screen.

C.4.14.4 Print Graph/Chart

Like the Print Window option, selecting Print Graph/Chart on the File
drop-down menu prints the entire active window. This option, however,
uses inverted colors to print graphs and charts.

C.4.14.5 Exit

Selection of the Exit option (shortcut: <Ctrl>+<Q>) on the File drop-down
menu closes the PowerMax PC program.
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C.4.15 Settings Menu

Options available under the Settings menu:

• Set Speedup to On or Off: ’Speedup’ (p. 115)

• Select the log file format. Refer to ’Log Data File’ (p. 108) and ’Log
Data to File’ (p. 107) for general information about saving data.

• Add a RS-232/serial sensor: ’Add RS-232/Serial Sensor’ (p. 116)

• Disable zero: ’Disable Zero’ (p. 117)
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C.4.15.1 Speedup

Selecting or de-selecting Speedup on the Settings drop-down menu con-
trols the host data.

Because of the natural thermal response of thermopile sensors, they have
a relatively slow response speed. To make faster measurements with
these sensors, use a speedup algorithm while taking power measure-
ments. The Speedup option lets the user set this algorithm on or off for dif-
ferent functions. The trade off to using Speedup is some loss of accuracy.

C.4.15.2 Log File Format

Select Log File Format from the Settings drop-down menu permits to add
or remove the following options from the log file:

• Sensor data

• Calculated (ratio) data

• Position-Sensing Thermopiles: X Position, Y Position

• (thermopile quad sensors only) X and Y positions 
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C.4.15.3 Add RS-232/Serial Sensor

Click Add RS-232/Serial Sensor from the Settings drop-down menu.

From the Add Serial screen, select the COM port to which the Power-
Max-RS sensor is attached. 

The COM port number is automatically determined by the computer. (If
needed, check in Device Manager for available COM ports.) In this exam-
ple, the selected COM port is 1.

When the COM port is selected, the PowerMax PC software scans that
port and identifies the connected sensor. 

As long as the sensor is correctly connected and powered up, the serial
number of the sensor is available for selection from the drop-down menu
in the software. In this example, the connected sensor is 0341I09R.

NOTE: This COM port will be queried as a Coherent sensor and if query is
unsuccessful it will not be added to the list. To remove this sensor from
the list please restart the PowerMax PC program.
116



Operation with PowerMax PC 
C.4.15.4 Disable Zero

The Disable Zero function disables the Zero Sensor button in the Front
panel. This function prevents accidentally zeroing the sensor during a
long-term test.

C.4.16 View Menu

Use this menu to select which part of the display is visible. Options avail-
able under the View menu:

• Display the full application view: ’Full Application’ (p. 118)

• Display the power/energy view only: ’Power/Energy’ (p. 119)

• Display the power/energy and plot view only: ’Power/Energy and Plot’
(p. 119)

• Show the large format display: ’Show Large Format Display’ (p. 120)

To display the full application view, use the shortcut <Ctrl>+<F>.
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C.4.16.1 Full Application

Example of a Full Application (shortcut: <Ctrl>+<F>) view:
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C.4.16.2 Power/Energy

Example of a Power/Energy data view:

C.4.16.3 Power/Energy and Plot

Example of a Power/Energy and Plot view:
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C.4.16.4 Show Large Format Display

Example of a Show Large Format Display view:
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C.4.17 Window Menu

When more than one window is open—that is, when there is more than
one sensor connected to the computer and each sensor has its own Front
panel open—this menu item lets users determine the relative position of
the open Front panels on the monitor screen.

Options available under the Window menu are:

• Tile the windows (this page)

• Cascade the windows (p. 122)

Tile Windows: 
Displays open Front panels edge-to-edge.

 

If five or more Front panels are open, only the first four panels tile—the re-
maining open panels stay in their current location.
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Example of two Front panels in a tiled view:

Cascade Windows: 
Displays all open Front panels, stacked and cascading from the upper left
to the lower right of the screen.

Example of two Front panels displayed in a Cascaded view:

C.4.18 Help Menu

Options available under the Help menu:

• Show context help (’Show Context Help’ (p. 123))
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• Display the PowerMax PC help file (’PowerMax PC Help’ (p. 124))

• Display version and copyright information about PowerMax PC
(’About PowerMax PC’ (p. 124))

C.4.18.1 Show Context Help

Opens a separate window that displays information about the screen item
currently under the mouse cursor (shortcut: <Ctrl>+<H>).

For example, a screen similar to the following will appear if you select
Show Context Help and then hover the cursor over the Reset button:
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To set this feature to Off, either de-select it from the Help drop-down
menu, or click the ‘X’ in the top right-hand corner of the Context Help
screen.

C.4.18.2 PowerMax PC Help

Displays the software Help file.

C.4.18.3 About PowerMax PC

Displays version and copyright information for the PowerMax PC software.

Refer to the example:
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